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Goals and Prerequisites

Dragon NaturallySpeaking lets you speak naturally to perform actions such as creating or editing documents,
using e-mail, finding online maps, news, images, and more. By reducing keyboard and mouse usage, you can
gain productivity AND avoid physical strain (on wrists, shoulders, neck, eyes…)

“Speaking to” your computer may feel strange at first. Be patient with yourself! This workbook aims to
efficiently present what an end-user should know (the resources in Dragon’s Help menu and on
www.nuance.com contain many details). This includes how to:

“Type by voice” efficiently, which includes:

 Dictating anything: punctuation marks, prices, dates, URLs, phone license plate numbers,
abbreviations, acronyms, Roman numerals, etc.

 Personalizing the Vocabulary with custom words and phrases, pronunciations, capitalization
properties and more, so that Dragon can transcribe exactly what you want even if what you
said could be written in different ways.

 Correcting Dragon’s errors so that it can learn from them.

 Formatting, editing, and revising text (whether or not the text was created by voice).

 And, in editions Premium and higher: creating custom commands to insert boilerplate text
and/or graphics.

“Command and control” your computer by voice, which includes:

 Saying commands to use the Internet and e-mail, search your computer, open programs,
click menus and buttons, close or minimize windows, switch between windows, etc.

 “Voice-pressing” a key (or key combination) on your keyboard.

Efficiency and Hands-Free Usage

We strongly recommend going through this workbook in order. (But if you used Dragon in the past, you may
wish to read the What’s New section first.)

When a lesson directs you to click an item (button, menu…), feel free to instead use your voice, or keyboard
shortcuts (underlined letters, Tab, spacebar…).

If hands-free usage is important to you, start by reading the lesson Controlling the Operating System and
Applications and see the Help about Dragon’s MouseGrid and commands for moving, clicking, and dragging
the mouse.

IMPORTANT: Starting the Microphone Check wizard or the Interactive Tutorial automatically turns off

Dragon’s microphone, which means a manual action is then needed to resume using Dragon. If this is a
concern for you, we recommend having someone present when you create or upgrade a profile, or use the
Interactive Tutorial or the Microphone Check.

To perform the exercises in this workbook, you should have basic familiarity with:

 Using Microsoft® Windows® to start or exit applications, open or save files, maximize windows, close
dialog boxes, copy or move items, browse to folders, cut and paste, etc.

 Simple word-processing concepts such as bullets, font size and font style, bolding and italicizing, right-
aligning and centering.
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Getting Started and Creating a User Profile

Dragon NaturallySpeaking is speaker-dependent software. It relies on information specific to you, including
what words and phrases you use often, how you sound, what audio device you use, and what software
settings you have. It stores this data in a set of files, referred to collectively as your “user profile” or just
“profile.”

Each person who uses Dragon must have his or her own profile. Your profile is very important. The more
personalized it is, the better your experience will be. To have the best possible start, it’s worth creating your
profile carefully (or upgrading it from a previous version of Dragon). As you will see later, there are many ways
for your profile to be refined over time.

This lesson will cover creating (or upgrading) a user profile. But first, let’s address what Dragon needs in order
to get good audio input from you. Here are important notes about placing your microphone and connecting it
to your computer.

Positioning and connecting your microphone

If using a headset, adjust it so that it feels stable and comfortable on your head
(it should not press your temple or glasses). The microphone’s listening side must
face the side of your mouth (not the front). It must not touch facial hair or catch
breathing sounds. (On standard headsets, bend the “boom” if needed.)

Most headset models can be rotated, so you can place the microphone on either
the left or the right side of your face.

You might experiment a bit to find what works best for you. Then, whenever you
use Dragon, aim for consistency in your microphone position.

IMPORTANT:

 Noise-canceling microphones only listen on one side. The listening side is
often marked by a dot or the word TALK, which may not be visible unless you
lift the foam cover slightly. Check that this side is parallel to your face, not
tilted.

 If you want to bypass your computer’s sound system, you can use a USB
microphone, or plug your regular microphone into a USB adapter.

 If your computer has only one audio jack (socket) and you want to use a
regular two-plug microphone, you must use a USB adapter or a Y-shaped
adapter.

 When you plug a microphone or adapter into your PC, be sure to push all the way into the audio socket or
USB port.

 If you want to test your microphone independently of Dragon, you can use Sound Recorder, a Windows
accessory accessible from the Start menu.
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 You may also wish to check the audio settings at the level of
Windows: see the “Recording devices” section of the Control
Panel. (In the example illustrated here, both Bluetooth and
USB are available.) This is accessible by right-clicking the
loudspeaker icon on the System Tray.

 Some PCs, after you connect a microphone, automatically
bring up a small window associated with this “audio system
event”. (Its window may be hidden behind other windows.)
Before closing this window, verify that what is highlighted on
it is the Microphone item (and not the Line In item).

 If your microphone model has a mute switch, make sure it is
in the ON position!

Important advice to remember whenever you use Dragon:

If your microphone type connects through a USB port on your computer, we recommend you plug it in before
starting Dragon. This applies also to the USB dongle required to use a Bluetooth microphone.

If you use a Bluetooth microphone, make sure that it is not just powered up, but also active (that is, in “call
mode”). On the Plantronics Calisto microphone, this is achieved by pressing the headset’s button. Please see
your microphone’s user guide for details, including how to charge the headset and how to pair it with the
dongle if necessary.

Upgrading one or more profiles

Dragon 12 can upgrade profiles from Version 10 or 11. If you have such a profile, you should upgrade it and
use it in Dragon 12; this allows you to benefit from refinements you had previously made (in terms of acoustics
and language model, as well as options, plus custom commands if applicable).
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Dragon 12’s Upgrade Wizard can automatically detect such
profiles present on your computer. (This wizard is available any
time from the Windows Start menu, under Dragon
NaturallySpeaking Tools.)

The Upgrade Wizard will list all available profiles. Use its
Remove button as needed so that only the desired one(s)
appear.

If a profile you want is not in the list (for example because it is
on an external disk), use the Browse button to designate it.

Once the list contains only the profile(s) you wish to upgrade
now, click Next.

IMPORTANT: The length of the process depends on how much data there was to upgrade. After the

upgrade completes, launch Accuracy Tuning to ensure that your profile can benefit from all your previous
acoustic data. (See the Audio menu and Help for details).

Creating your profile (or adding an audio source)

Before you start Dragon, connect your microphone (see above). If you wish, test it by making a sample
recording in Windows Sound Recorder.

The profile creation process includes indicating your microphone’s type and verifying your sound system, as
well as an optional step where you read aloud for a few minutes so that Dragon can start adapting its acoustic
model to the way you sound.

To get started optimally, note:

 If you want to test your microphone independently of Dragon, you can use Sound Recorder, a Windows
accessory accessible from the Start menu.

 Consistency matters! For best results, create your profile in your “normal” environment, with the same
background noise and equipment as you will usually have when you use Dragon.

 For editions Premium and higher: If you already have a Dragon 12 profile and just want to use another
type of audio input device, add a source to your profile instead of creating a separate profile. (Open
the DragonBar’s Profile menu and choose “Add source to current User Profile.” Details below.)

 For Bluetooth wireless headsets, see the Help and the manufacturer’s documentation. Familiarize
yourself with how to charge your microphone, power it up, turn it on (put it in “call mode”), and
ensure it is paired to its USB dongle.

Step 1: Launch Dragon (you can double-click its desktop icon or pick it from the Start menu). If Dragon has
never been used before on this PC, the Profile Creation Wizard will then open automatically.
Otherwise, choose New User Profile in the DragonBar’s Profile menu, then click New.

Step 2: Answer the questions presented by the wizard’s screens. This includes giving your profile a name. (No
need to overthink this, but you may want the name to reflect the date of creation, for instance
MJones-Oct2012). Answering the age question is optional but we recommend it since it may help obtain
higher accuracy. Dragon contains an acoustic model for “young voices” (pre-puberty, typically up to
the age of 13).
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The wizard will ask you to specify a “region”. Dragon will use that information to choose your profile’s
underlying Auto-Formatting options and Vocabulary. For instance, this will affect whether Dragon
uses the spelling “colour” instead of “color” as well as how it writes currencies or units such as lbs, $,
USD and AUD (ISO currency codes).

Note: Dragon 12 has no special Vocabulary for Canada. Picking “Canada” in the Region l ist results in
the same spellings as picking “United States.”

TIP: Once your profile is created, you will be free to customize it, including modifying Auto-

Formatting Options and Word Properties (as described in this workbook and the Help). For example,
Canadian users may wish to give the word “organize” the alternate written form “organise”.

The next screen gives you an opportunity to choose from a number of broad accents. If unsure which
accent to pick, see the Help. Note: Dragon will later adapt to the sound of your voice, as you dictate
more and more and run the Accuracy Tuning process.
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Step 3: On the next screen, indicate which type of audio source you are about to use. Note: even in editions
that support transcribing recordings (editions Premium and higher), we suggest starting with a
microphone source type. This is because, by dictating directly to your PC, you can get used to speaking
in a way that gives best results and you can personalize the vocabulary (see the next chapter), which
means that once you do begin to make recordings and have Dragon transcribe them you will get better
accuracy in those transcriptions.*

The default type is a microphone plugged into the Mic-In jack (audio input socket). If you use a USB
adapter on a standard headset, be sure to pick the USB option here.
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Note:

 If your PC has only one audio socket (like on mobile phones), you must use a USB adapter (or
USB microphone) or a Y-shaped adapter (“splitter”).

 In editions Home and higher, you can use as a microphone a supported iOS or Android
smartphone (or other supported device) on which you have downloaded the Dragon Remote
Microphone app (see our web page: www.nuance.com/dragon/remote-microphone).

 The lower editions of Dragon do not support all the source types. In addition, they do not
support having multiple sources in one profile; this means that they require you to create a
profile for each source type you wish to use (for instance, one for smartphone and one for your
USB microphone or standard microphone plugged into a USB adapter).

 If your edition supports Bluetooth and you plugged your Bluetooth microphone’s dongle into
your PC before starting Dragon, this screen will include a Bluetooth option (“Enhanced
Bluetooth” for a wideband Bluetooth microphone such as the Plantronics “Calisto II” BT-300).

The Help and the Nuance website contain details for special audio sources such as Bluetooth wireless
(source available in editions Premium and higher) or the Dragon Remote Microphone app for iOS and
Android devices (source available in editions Home and higher in Dragon 12).
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The Hardware Compatibility List on the Nuance website contains specifics such as the recommended
settings for a particular model of microphone or recorder.

About the Dragon Remote Microphone app as source

The smartphone (or other device on which you downloaded the app) must be connected to the same
Wi-Fi network as the PC on which you use it with Dragon.

When you set up the Remote Microphone app on a supported Android or iOS device, Dragon offers a
barcode (QR code), so you can just point your device’s camera at the computer screen to capture the
information needed. (Later on, you can use the DragonBar’s Tools menu to bring up this screen.)

Note: In public locations such as restaurant or coffeehouse chains which require that you logon or
accept the terms of service, the typical security configuration does not allow the mobile device to
communicate with the computer, therefore the Remote Microphone app feature is not supported.

For details about setting up and using the app, please see the KnowledgeBase article on the Support
section of the Nuance website: http://nuance.custhelp.com/app/answers/detail/a_id/6294 (this
includes a link to Technote 6825: "Information on testing the connection between Dragon
NaturallySpeaking and the Dragon Remote Microphone application".)

About spoken recordings as source

Please see our website (www.nuance.com/dragon/transcription-solutions) for illustrations and details,
including Nuance’s free Dragon Recorder app for smartphones and related devices.

Note: Dragon works with one voice at a time, so it cannot transcribe interviews or meetings directly.
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Dragon’s transcription feature (available in editions Premium and higher) can be particularly useful to
exploit what you dictate while observing something (such as during a field inspection) or after an event
(such as a meeting or a class). Once you have set up your profile for transcription use, you can use
Dragon to transcribe your spoken recordings.

TIP: If your recording was very “rough” or if it contained voices other than yours, consider the
practice of “echoing” or “re-speaking” rather than (or in addition to) transcribing the recording: while
listening to the recording and pausing it as needed, you dictate to Dragon what you hear. Among other
advantages, this gives you the opportunity to improve upon the original words, or add to them,
including adding punctuation that had not been spoken.

Before recording files for Dragon to transcribe, note:

 We recommend first using Dragon for real-time transcription (dictating directly to your PC)
because this gives you a chance to practice speaking clearly, in long phrases, and with
punctuation. From what you see Dragon transcribe as you dictate, you get feedback on how
clearly you are dictating. You also get ideas as to how to personalize your profile’s vocabulary,
for instance by noticing jargon or phrases you should add to the vocabulary so that Dragon will
be able to write them with the spelling, capitalization, and spacing you desire. (In addition to
adding words and phrases, be sure to designate to Dragon representative text documents so it
can learn what words and phrases you often use.) As explained further in this workbook,
vocabulary personalization is very important; it prevents many recognition errors!

 Learn the essential operations of your digital recorder or the recorder app on your smartphone
(starting and stopping recordings, for instance). Also, verify that the recorder is set to the
correct time and date as well as optimal settings for speech recognition (see details on
individual models tested by Nuance at http://support.nuance.com/compatibility).

 Some digital recording devices come with special software to manage recordings (including
transferring them to a computer and converting their format if necessary). Check your device’s
documentation and take the steps required to set up your device, including installing the
software it may require.

 In Dragon 12, setting up a recorder source requires reading a training text into your recording
device for a minimum of four minutes. (Note: making your training recording longer than four
minutes is a good idea, since it will provide Dragon with a bigger acoustic sample from which to
adapt to the sound of your recorded voice.)

Adding and managing sources

Below the Premium edition, you must create a profile for each source (type of audio input device).

In editions Premium and higher, if you already have a Dragon profile and want to use another type of
audio input device, add a source to your profile instead of creating a separate profile: open the
DragonBar’s Profile menu and choose “Add source to current User Profile.” This opens the New
Dictation Source dialog box, where you can pick the desired source.
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Remember that personalizing the Vocabulary is one of the keys to getting Dragon’s full benefits! Having
multiple sources within a profile means that, no matter which audio input device you use, the same
Vocabulary will be used — and refined — each time you use Dragon. For example, the phrases and
capitalization properties you taught Dragon while using a smartphone as a source will also be available
when you use a USB microphone.

TIP The Open User Profile dialog box (available from the Profile menu) lets you view and manage your

sources:

To switch to another source in your profile
once you start using Dragon, open the
DragonBar’s Profile menu and use Open
User Profile or Open Recent User Profile.

If you wish to delete a source, open the
Open User Profile dialog box. In that box,
highlight the line corresponding to the
desired source, then click the Source
button and pick Delete from the resulting
menu.

Once you have indicated the source you are about to set up, Dragon will check your audio system and
adjust its volume setting. This step is called the Microphone Check (formerly “Audio Setup Wizard”).

Note: If you are using a Bluetooth microphone, make sure that it is not only powered up, but also
active (that is, in “call mode”). On the Plantronics Calisto microphone, this is achieved by pressing the
headset’s button. Please see your microphone’s user guide for details, including how to charge the
headset and how to pair it with the dongle if necessary.
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Step 4: Click Start Volume
Check and read
the boxed text in a
clear voice, the
way you plan to
speak when
working with
Dragon. Here,
punctuation is
recommended but
not required.

When Dragon lets
you know it has
heard enough,
click Next. The
next screen is
similar.

TIP: It’s best to read the boxed text exactly as it is written. However, if you cannot read it, feel free

to speak some sentences of your choice until you hear a beep.

Dragon then verifies that your sound system is acceptable for speech recognition. (For details, see Help
and, if needed, the Technotes at support.nuance.com.)

Note:

 If you chose as source the Dragon Remote Mic app, Dragon’s wizard will present a screen to help
ensure that your smartphone (or other Wi-Fi-enabled device) “finds” your profile on your
computer. Also, instead of the volume and audio quality check, it will present a short sentence to
read aloud for calibration.

 Some computers offer several places for you to plug in your microphone. If you get poor results
with one, consider the other(s) -- and if you use a docking station, you may get better results if you
connect the microphone to a port on your laptop itself, not on the station. Once you’ve identified
which port works best, aim to always use that port for your microphone. (You may wish to mark it
with a piece of tape.)
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Step 5: If you do not choose to skip the initial training reading, Dragon then presents a short prompt; click Go,
then read it aloud. When the “Select Text” box appears, choose one of the texts and click OK. (If later
you wish to read another text to further train Dragon, you can do so from the DragonBar’s Audio menu,
or from the Accuracy Center.)

Note: We recommend the reading “What To Expect From Speech Recognition” but the list also offers
readings for children.

The following describes the default “General Training” process, which presents the text one prompt at a time.
(The Help contains details on the “without prompting” alternative, which presents the text as one whole
document for you to read at your own pace, from the screen or from a printed page; this can be more
convenient for those who have a strong accent, speech impediment, or some difficulty with reading from the
screen.)

Click the Go button (at bottom left) and read each prompt exactly as it is displayed. (Once you finish reading a
prompt, Dragon will automatically present the next one.) The words will turn gray once Dragon has “heard”
them, but there is no need to wait for this to happen: just speak at your normal pace, clearly and naturally.

TIP: During acoustic training, Dragon learns how you sound when you dictate, therefore you should aim to use

the same tone, pace and volume you are likely to use day-to-day. This will help Dragon recognize your future
dictations most accurately. Saying punctuation isn’t required during this reading, but it’s a good idea to say
at least the periods, to get into the habit. (Later, you will learn to dictate all punctuation marks and symbols.)

Take your time. Try to read
naturally but precisely what is
on the screen. If Dragon needs
to hear you re-read
something, a yellow arrow will
show you where to resume.

The Redo button lets you
move the arrow back, which
you may want to do if you
realize you just misread
something.

If for any reason you have
trouble with a particular
word, use the Skip button.

If you need to take a break,
cough or sneeze, click the
Pause button. That button
will then be labeled Go; click
it when ready to resume.

*

Note: If the thin bar under the prompt turns red, the volume is too high. Verify your microphone’s position.

Once Dragon has heard enough, it takes a moment to process the acoustic information you just provided.
Profile creation is now almost complete!

A first opportunity to adapt your profile’s vocabulary

Dragon will then offer to start adapting its Vocabulary. This step is just a basic initial customization which
analyzes texts in your My Documents folder as well as e-mails sent from certain installed email programs.
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(Later, you will be able to designate specific documents for analysis. You do NOT need to copy documents
into your My Documents folder in order to have Dragon analyze them!)

Feel free to skip this step, but as soon as possible after your profile is created, advantage of the powerful
customization tools described in the following lessons. (For example, you can import lists of words -- with
spoken forms as warranted. Remember that, to obtain high accuracy, it’s important to give Dragon a chance to
analyze documents containing your words “in context” as opposed to just adding words and phrases to the
vocabulary.)

IMPORTANT If some of your documents and sent emails are in a different language or in a radically

different style, skip this automatic step and, once your profile is created, have Dragon learn from specific
documents that contain only the same language as your profile.

Scheduling Dragon's periodic tasks

The next screen will give you the opportunity to schedule Dragon’s Accuracy Tuning, a process which, after you
start using Dragon, can refine your profile automatically based on what you have already dictated.

IMPORTANT Once you actually start using Dragon, you will be free to launch this process manually at

any time (from the DragonBar’s Audio menu); some customers launch it shortly after they turn on their
computer or right before they take a break from their computer to go to a meeting, make a call, have a
meal…). For Dragon’s scheduled tasks to run automatically, you must choose a time when your computer will
be on (not asleep, not hibernating) but Dragon is not running (this includes Dragon being in QuickStart—see
the Help for more information).

To schedule Accuracy Tuning, click the Change Schedule button on the screen Dragon presents. Dragon then
presents the dialog box Select Time and Frequency. Be sure to also click this dialog’s Language Model tab, so
you can pick a suitable time for the Language Model Optimization. (Note: Language Model Optimization is
typically much faster than Acoustic Optimization. We recommend running it daily.)

Before your profile opens — caution with desktop icons

The last screen of the Profile Creation Wizard contains a link to the Help article about changes between this
and previous versions (condensed in the What’s New section of this workbook).
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After you exit this screen, Dragon 12 will automatically bring up its Interactive Tutorial, which contains short
progressive simulations and allows you to restart any lesson. We recommend that all users take advantage of it.

After you exit the Interactive Tutorial, the Sidebar and the Tip of the Day window will open.

IMPORTANT By default, the Dragon Sidebar (a thin resizable window that presents commands and tips) is

set to open automatically when a user profile opens.. In Dragon 12.5, it is set to “Floating” by default, but in
Dragon 12.0, it is set to dock to the right. If you typically keep desktop items on the right side of your screen,
the Sidebar may move them, like other Windows sidebars would. For this reason, you may wish to rearrange
your desktop items before the Sidebar opens, or set your desktop to Auto-arrange. (See the Sidebar’s Help. Its
right-click menu includes Floating and Auto-Hide.) The automatic opening of the Sidebar can be disabled from
the Miscellaneous tab of Dragon’s Options dialog.

Now that your profile is created, we encourage you to explore Dragon’s options to suit your preferences,
including changing numeric keypad hotkeys. (This is particularly relevant to laptop users, and people who like
to use their numeric keypad for data entry.) This workbook’s lessons will progressively introduce you to options
that most users should consider. Below are two of them: the Natural Language Commands for specific
applications and the Speed-versus-Accuracy slider.

Important options: Natural Language Commands and Speed vs. Accuracy

After you create your profile, Dragon presents a special message if it determined that your computer’s
characteristics wouldn’t allow optimal performance. This message informs you that Dragon has adjusted the
defaults for two of its options as follows:

 The Speed versus Accuracy slider was moved toward speed.

 The Natural Language Commands for Microsoft Word, Excel, PowerPoint, and Corel WordPerfect
were disabled. (The lesson “Controlling your Desktop and Applications” addresses these large sets of
flexible commands. Note: not all editions and languages of Dragon contain these commands.)

Later, you can easily reverse these changes through Dragon’s Options dialog, depending on your particular
needs: you can enable or disable the Natural Language Commands for any of these four applications
individually, and you can experiment with various settings of the Speed-versus-Accuracy slider (seen in the
picture below).

IMPORTANT Other options available on the Miscellaneous tab include having Dragon start in its sleep

state (useful for persons who cannot use their hands), as well as two new features of Dragon 12:

 Disabling the “tracking” of menus, buttons and other interface elements

 Disabling the automatic opening of the Dictation Box where Dragon does not have Full Text Control
(examples: in PowerPoint or Emacs, as well as in Web browsers Firefox and Chrome).

Details about these important concepts are accessible from the DragonBar’s Help menu.
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The Help provides more details, including suggestions for optimizing Dragon’s performance on your computer.
For instance, in Dragon 12, you can choose to disable the ability to open items from the Start menu or the
desktop at any time, even if they are not visible. You can also choose to disable the shortcut commands for
Facebook and Twitter, and shortcut commands to create new emails, tasks or appointments.
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IMPORTANT

Now that your user profile is created, you could start
dictating. Before you do, however, we recommend
you take a look at the Help menu, which includes a
like to User Guides and to Technical
Support/Customer Service.

Also, it’s a good idea to begin personalizing the
Vocabulary as soon as possible, since this plays a
crucial role in accuracy and efficiency.

Note: If you’ve used a previous version of Dragon, we
recommend you read the What’s New section of this
workbook.

Key points about getting started with Dragon

 Each person who wants to use Dragon must have his or her own profile. Creating one is a short process
guided by a series of screens. Profiles from versions 11 and 10 can be upgraded with the Upgrade
Wizard. (Important: After upgrading, launch Accuracy Tuning from the Audio menu).

 Make sure your microphone is properly connected and positioned, and the appropriate audio source is
selected. See our website for details on special sources like recorders and wireless microphones, as
well as the use of the Dragon Remote Microphone app or the Dragon recorder app with Dragon.

 In editions Premium and up, you can add a source to an existing profile (for instance, if after using
Dragon with your USB microphone you wish to also dictate using your smartphone as a wireless
microphone). Whatever source is used, you will access the same vocabulary and optional settings (as
well as custom commands, if applicable).

 Even if your edition supports the transcription of spoken recordings, we recommend starting out with a
microphone source as opposed to a recorder source.

 When reading a training text, speak clearly but naturally using the same volume, pitch and pace you
are likely to use day-to-day. Try to read what is prompted as if you were dictating your own words. Use
the Redo and Skip buttons as needed, as use the Pause button if you need to clear your throat or speak
to someone.

 During profile creation, Dragon offers to perform a basic adaptation of your profile’s vocabulary based
on text in your Documents folder as well as on sent e-mails. Feel free to skip that step but be sure to
use Dragon’s powerful personalization tools as soon as possible after profile creation finishes.

 Dragon's scheduled tasks are designed to help improve accuracy over time. Be sure to schedule them
for a time when your computer will be on but Dragon will not be running.

 By default, the Sidebar opens automatically when a user profile opens. In Dragon 12.5, its default is
“Floating” but in Dragon 12.0 it is “Docked to the right” – so if you typically keep desktop items on the
right side of your screen, the Sidebar may move them. For this reason, you may wish to rearrange your
desktop items before the Sidebar opens, or set your desktop to Auto-arrange. (You could also set the
Sidebar to Floating. See the Sidebar’s Help and right-click menu.)
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 Note: If you are using a Bluetooth microphone, make sure that it is not only powered up, but also
active (that is, in “call mode”). On the Plantronics Calisto microphone, this is achieved by pressing the
headset’s button. Please see your microphone’s user guide for details, including how to charge the
headset and how to pair it with the dongle if necessary.
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Learning More and Getting Help

Dragon NaturallySpeaking offers so many tools, commands, and features that it would be impossible to cover
them all in detail in this workbook. This lesson presents several ways to find more information as you start
using the software—be sure to take advantage of the available resources!

Please see the card that comes in the Dragon NaturallySpeaking box. It includes important notes about
installing Dragon as well as sample lists of commands and what you can say to dictate special characters,
times, dates, postal codes and more. (The latest version of this quick reference guide is available for
download on the Nuance website.)

CAUTION: By default, in Dragon 12.0, the Dragon Sidebar is set to open automatically, docked to the right,

when your user profile opens. If you typically keep many desktop items on the right side of your screen, know
that the Sidebar may move them (like other Windows sidebars would). Before the Sidebar opens, you may wish
to rearrange your desktop items, or set your desktop to Auto-arrange. Note: In Dragon 12.5, the Sidebar is set
to “Floating” by default.

The Accuracy Center and Accuracy Assistant

The most important features of Dragon are accessible directly from the DragonBar's menus. The Accuracy
Center offers a central location to access many of them and get guidance on which one to use when.

Step 1: Say Open Accuracy Center. You can also click the DragonBar’s Help menu (or say Switch to DragonBar
then say Click Help) then Improve my Accuracy.

Step 2: Click the link that interests you. You can also say its name immediately preceded by the word "click”.
("Require 'click' for HTML" is an option enabled by default in new Dragon 12 profiles, to help prevent
unintended recognitions. See the Commands tab of the Options dialog.)

TIP You can activate links without saying their whole name: for instance, instead of “click add a list of

words to your vocabulary”, you could say just “click add a list”.

The link “Which tool to use first?” opens the Accuracy Assistant, which presents a set of questions to help
determine what you can do to increase accuracy in a given situation.

The Help and the Performance Assistant

The DragonBar’s Help menu gives you access to the on-screen Help topics (articles) and the Performance
Assistant (a collection of suggestions for what you can do to increase Dragon’s speed).
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You can also open the Help at any time by saying commands such as give me help.

You can use the Help window’s Table of Contents, Index, and Search tabs. For instance, entering the word
“punctuation” in the Search field brings up topics including “Dictating punctuation and symbols” and “Selecting
characters and words.” Note: like in search engines, you can indicate phrases by putting quotation marks
around them.

From the Help window, you can also print articles of your choice or mark them as favorites.

TIP: To launch a Help search at any time (no matter what is active on your screen), you can use the shortcut

command “search Dragon Help for…” naming the word(s) you wish to search for. For instance, you could say
“search Dragon Help for Firefox”. Note that the search keywords you name in this command will be considered
individually unless you put them in quotes: for instance, “Search Dragon Help for open-quote Dictation box
close-quote.”

Dragon also provides contextual help: from its dialog boxes, the Help button (or question-mark icon) or links
take you directly to the relevant article in the Help.
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The Dragon Sidebar: “What Can I Say”

At any time, you can ask Dragon to display its Sidebar, a resizable vertical window meant to help users discover
and remember important tips and commands. (It can be made very thin.)

If a major application such as Microsoft Word is active, the Sidebar’s first tab will show commands for that
application. Otherwise, it will show a list of commands that are not specific to one application (Global
commands).

The Sidebar also contains a hideable tab for mouse commands (dragging, clicking, etc.), as well as a tab for
custom-created commands (a feature of the editions Premium and higher). In addition, in its top right corner
are icons to open important resources: the Command Browser, Vocabulary Editor, Options dialog, and Help.

CAUTION: By default, the Dragon Sidebar is set to open automatically when your user profile opens, and in

Dragon 12.0 it is docked to the right; this means that, if you typically keep desktop items on the right edge of
your screen, the Sidebar may move them (as other Windows sidebars would) and therefore disturb your icons’
arrangement. Therefore, if you have Dragon 12.0, you may wish to rearrange those desktop items before the
Sidebar opens, or set your desktop to Auto-arrange. NOTE: in Dragon 12.5, the default setting is Floating, not
docked; this means that the Sidebar may cover part of the currently-active window, but it avoids disturbing the
arrangement of desktop icons.

The illustrations in this chapter show the Sidebar in various widths, its right-click menu (including the monitor
switch for those who have two monitors) and its Mouse tab alongside one of its linked Help articles.
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Step 1: Open the Dragon Sidebar. Voice commands for this include open Dragon Sidebar, show Dragon
Sidebar, and what can I say. You can also use the DragonBar’s Help menu.

Step 2: Explore the Sidebar and adjust it to suit your preferences. You can make its font size Small, Medium, or
Large. By clicking on its border and dragging it horizontally, you can make the Sidebar very thin. (Note:
doing so may hide some of its content, such as the top-right icons). If you don’t need to use mouse
commands, we suggest hiding its Mouse tab.

Note: One way to access details about the Sidebar is to use its question mark icon (in the top right
corner). You can also say a search-keyword command such as search Dragon Help for Sidebar
commands.

Step 3: Practice activating the Sidebar’s links and tabs. To access the tabs by voice, you can say Dragon
Sidebar Home, Dragon Sidebar Global, and Dragon Sidebar MyCommands.

TIP To see commands beyond those presented in the Sidebar, you use the Help (take advantage of the

command “search Dragon Help for…” and the speakable links in the Sidebar itself). You can also use the
Command Browser, accessible from its icon on the Sidebar and with commands such as open Command
Browser. Below is a Command Browser screenshot showing commands for the Sidebar.

Step 4: Right-click the Dragon Sidebar. This opens its menu. Note what is available there, including hiding the
Mouse tab, hiding the Tips pane, setting the Sidebar to be Floating rather than Docked, activating
Auto-Hide, and printing the content.

TIP When a Sidebar pane has the focus, a thick blue line surrounds it.

The illustration below shows the Mouse tab and one of the Help articles related to mouse usage.
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The Interactive Tutorial

Available from the DragonBar’s Help menu, the Interactive Tutorial contains short progressive simulations and
aims to make the user practice important habits for efficient dictating, correcting Dragon’s errors, and editing
text. It includes important editing-related commands such as “go back,” Dictation Commands such as “cap,”
“all caps,” and “numeral…” as well an example of modifying an entry in the Spelling Window and accepting a
Smart Format Rule. We recommend that all users take advantage of it.

Note: When the Interactive Tutorial opens, Dragon automatically turns off its microphone. In each lesson, you
practice an important habit: turning the microphone on and off.
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While going through the simulations, you must speak just the current prompt (the green bolded text) and do so
in one breath (without pausing within it). Otherwise,

If Dragon hears unsusable audio input, it presents the following information message:

The Tutorial

The regular Tutorial is available from the DragonBar’s Help menu. You can go through it from start to finish,
using the Next link, or you can jump directly to the sections that interest you most.
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The User's Guides

The latest User's Guide is available as a PDF on the Nuance website alongside the Quick Start Guide, the Calisto
Bluetooth User Guide, and other resources. The DragonBar’s Help menu gives direct access to the website’s
User Documentation page.

When viewing the PDF file, you can click chapter headings to jump to specific topics, and you can print out
sections as well as the entire file.

TIP: If you are using a Bluetooth microphone, be sure to read its User Guide. Before using the microphone

with Dragon, charge the headset and make sure that it is not only powered up but also active (that is, in “call
mode”). On the Plantronics Calisto microphone, this is achieved by pressing the headset’s button. Please see
your microphone’s user guide for details, including how to charge the headset and how to pair it with its USB
dongle if necessary.



Copyright  2013 Nuance Communications, Inc. All rights reserved 24

Key points about learning more and getting help

 This workbook is meant to get you started efficiently and cover essential concepts and tips. Other
resources include the Help, the Sidebar, the Accuracy Center and its Accuracy Assistant, the
Performance Assistant, as well as the Nuance website, which includes tips, FAQs, video demonstrations
and the Knowledge Base of “TechNotes”.

 Be sure to explore Dragon’s Help menu. You can open the Help at any time with generic commands
(give me help…) or “shortcut” commands that include the word(s) to search for, such as search
Dragon Help for Roman numerals.

 The Sidebar is a thin vertical window which displays many commands and tips. You can open it by voice
commands or through the Help menu. You may use mouse or voice to access its panes, tabs, links and
icon buttons. Its right-click menu gives access to options to change the Sidebar’s behavior and
appearance (including making it Floating rather than docked, hiding the tips or the Mouse tab) as well
as print its content. To see all its commands, use the Command Browser.

Beyond these resources, consulting an experienced Dragon trainer for specific guidance and customizations can
be particularly efficient for users who have special environments, workflows, equipment, or challenges (for
instance, challenges related to motion, vision, or speech fluency.)

Now that you know how to access many resources, let’s learn the most important aspects of using Dragon,
starting with an often-overlooked but crucial one: personalizing your profile’s Vocabulary.
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Why Personalizing the Vocabulary is Essential

Transcribing a person’s speech presents acoustic challenges, such as accent and ambient noise. There is also a
lexical challenge: for the transcription to be precisely accurate, familiarity with the terms used is necessary.
For instance, even an experienced medical secretary would have trouble transcribing for an attorney’s office!
And a newly-hired transcriptionist would have to not only get used to the voices of the various speakers, but
also to learn what spellings and formatting they want, including acronyms, abbreviations, special phrases,
names of people, places, products, etc.

An unusual name may seem commonplace to you because you use it frequently, but a person who hears it for
the first time may not be able to spell it: that name is not yet a part of this person’s vocabulary. Similarly, if a
word or phrase is not in Dragon’s active vocabulary, the software cannot transcribe it correctly without a little
instruction.

When you created your User profile, you provided information which Dragon incorporated into its acoustic
model. To get optimal accuracy, you should also help the software adapt its language model and Vocabulary.
Lexical customization ensures that what you dictate is transcribed with the desired spelling, spacing, and even
capitalization; Dragon provides many powerful tools for it, so this important investment need not take much
time. The Help contains much information about personalizing the Vocabulary—including how you can even
benefit from the customizations done by others.

Key points about Vocabulary customization

 As soon as you have created a User profile, you can start dictating, but note that taking a moment to
start customizing the Vocabulary for you is a good investment to make right away, since it helps Dragon
“get it right the first time” (including spelling, capitalization, and spacing) and it needn’t take much of
your time. Personalizing the Vocabulary early and often is strongly recommended. The following
pages will show you how.

 Dragon offers many simple and powerful Vocabulary tools to allow you to make your dictations faster
and more convenient.
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Customizing the Vocabulary—Using the Vocabulary Editor

Dragon’s Vocabulary Editor lets you view what can be transcribed from the computer’s active memory; it also
allows you to add new entries, as well as edit existing entries—including their Spoken Forms and Properties.

Let’s explore the Vocabulary Editor’s interface:

Step 1: Say Edit Vocabulary (you can also use the DragonBar’s Vocabulary menu or the Accuracy Center). The
Vocabulary Editor opens; its scrollable window lists the entries currently in Dragon’s active Vocabulary.

Take a moment to scroll through the list. You will see names of people, places, institutions and
products, as well as common words, phrases, and abbreviations. Most entries only have a Written Form
(left column) but some also have at least one Spoken form. The Spoken form is an important feature,
as you will see.

Step 2: Open the Display drop-down list (located at the bottom) and choose Words Containing Spaces. Other
Vocabulary displays include Words Containing Digits, Words Containing Capitalization, and Words with
Special Properties. By browsing these, you can learn more about what the software uses to transcribe
your dictation. You also get ideas about what entries you might add or edit.

Adding Vocabulary Entries: Words, Phrases, Acronyms…

You can quickly search for a particular Vocabulary entry by entering it in the Written Form field. If it appears
in the scrollable list, it is already in the active layer of the Vocabulary. If not, say or click Add to bring it in.
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CAUTION When adding an entry to the Vocabulary, be sure to spell and capitalize it correctly! Otherwise, it
will appear misspelled in your documents every time you dictate it.

Some of the "words" in the Vocabulary Editor aren't single words. Of course is listed. So is as well as. There are
also names of people, places, products, and institutions: Mother Teresa, Madison Square Garden, KitchenAid,
Brigham and Women's Hospital, Marine Corps, Library of Congress, Babe Ruth, Accounts Payable, George
Washington, Johnson & Johnson, Division I, LAN Server…

These help the software resolve spelling and capitalization ambiguities: if the Vocabulary didn’t contain the
phrase Mother Teresa, dictating it would probably produce the transcription "mother Theresa"—because the
word mother is usually not capitalized, and because Theresa is the more common spelling of the name. Having
the phrase in its Vocabulary helps Dragon know that the words “Mother” and “Teresa” are likely to occur
together, and hence helps Dragon choose the desired capitalization and spelling.

Also, recognizing long sounds is easier than very short sounds. A and the are acoustically very similar, as are in
and an. Longer words, like “chrysanthemum”, contain more acoustic information.

We strongly recommend adding personal “multi-words”; this will later save you time since you will not have to
adjust their spelling and capitalization after transcription.

Exercise 1: In the Vocabulary Editor, search for a few familiar names such as your own first and last names,
your town, company, colleagues or relatives; if necessary, add them using the Add button.

TIP When adding names of people, consider nicknames and diminutives as well as formal names, particularly

for names that are very short or that can be spelled different ways: for instance, one might add Liz Jansen,
Lizzie Jansen, Elizabeth McGee Jansen, Jennifer B. Wolff, Jennifer Wolff, Jenny Wolff, Jenn Wolff, Judge
Wolff, Scooter Wolff…

This idea applies to more than just names. Whenever you add an item to the Vocabulary, think of its possible
variations: singular/plural for nouns, conjugated forms for verbs… Remember, if something is not in the
Vocabulary, the software cannot recognize it, so don’t hesitate to add items even if you think you will not
dictate them very often!

Exercise 2: Open a word processor (such as DragonPad, available from the DragonBar’s Tools menu or from the
command “open DragonPad”) and start a list of Vocabulary entries relevant to you; some suggestions
are below. (Soon you will learn how to import these entries all at once.)

 jargon and phrases specific to your profession (such as distro, site visit and non-State)

 names of places, facilities or organizations (such as Building 52, or County Adoption Center)

 names of products (such as MicroPore tape or Latex Exterior Semi-Gloss)

 acronyms, part numbers, codes (such as FICA, 501c(3) or RX-70y)

 names of people (coworkers, clients, friends, relatives…) including full combinations for names
that could be spelled differently (Kristin, Gene, Steven, McGregor, Wolfe…) or are very short (Kip, Kit,
Dee…) since this helps Dragon resolve acoustic ambiguities.

TIP If you are using Dragon for work, your employer may be able to give you some lists that could save you

time, particularly if they are already in electronic form: lists of staff or clients, departments, units or divisions,
products, trademarks, building names, as well as glossaries of terms and acronyms. Starting from such lists
doesn’t just save time; it may also help add these items with their official, correct spelling!
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The importance of Spoken Forms

Radio programs often tell their listeners “let us know how to pronounce your name” because some names could
be pronounced in several ways and some are not pronounced “the way they are written” (due to silent letters,
for instance). This is true for more than just names. Acronyms are often pronounced letter by letter, but not
always: ASAP is pronounced "ay sap" by many people. These facts are addressed by an important Dragon
feature: the Spoken Form.

From the Display drop-down list of the Vocabulary Editor, choose “Words with spoken forms only.” Take a
moment to scroll through and look at existing spoken forms; you will get ideas for what kinds of entries warrant
them and how they can be written.

TIP Vocabulary entries may have more than one spoken form. You may add spoken forms to custom entries as

well as to existing entries, in order to be able to dictate them as comes naturally to you: for example, to enter
the symbol ©, you might like to say “circle see” instead of the existing spoken form “copyright sign.”

Note that entries containing symbols, digits, or unusual spacing are particularly likely to warrant a Spoken
Form. If the written form of a word contains any punctuation, consider providing a spoken form so that there is
no doubt as to how the item will be pronounced.

If you add e-mail addresses to the Vocabulary, giving them a Spoken Form can make them quicker to dictate:
for instance, “Amy and John at yahoo dot com” or even just “Amy and John at yahoo” for
AmyT&JohnB@yahoo.com.

Note: Spoken forms must not include punctuation, abbreviations, or symbols. Below are a few examples.

Written Form: The Man from U.N.C.L.E
Spoken Form: the man from uncle
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Written Form: St. Clement's Hospital
Spoken Form: Saint Clements Hospital

Written Form: Soddy-Daisy, TN.
Spoken Form: Soddy Daisy Tennessee

Written Form: Trenton-Mercer Airport
Spoken Form: Trenton Mercer Airport

Adding Spoken Forms allows you to dictate in the way that is most natural, but also quickest for you. In
addition to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic
substitution: you say something short and easy, and Dragon types something longer or “trickier” to say (or to
remember). This capability can be used to give consistency and clarity to your writings; groups can take
advantage of it to help everyone easily comply with recommendations like avoiding abbreviations and
potentially confusable items.

To add a Spoken Form in the Vocabulary Editor:

Step 0: First, decide what you want to say, and what Dragon should transcribe when you say it.

For example, suppose Central Lexington United High School is often called CLUHS or "cluss". Do you
want Dragon to type CLUHS or Central Lexington United High School?

Step 1: In the Written Form field, type what you want Dragon to write. Be careful with its capitalization,
spacing, and spelling — including symbols or punctuation marks if needed, as in E*TRADE.
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Step 2 In the Spoken Form field, type what you will actually say. In some cases (as in our “cluss” example), you
will enter one or more “made-up words” to represent the desired sound.

Step 3: Say Add or press Enter.

Note: If you entered a “made-up word” in the Spoken Form field, Dragon then brings up a dialog box to
tell you that it doesn’t know that word and will therefore guess its pronunciation — this gives you a
chance to catch any typo you may have made in the Spoken Form.

Illustrated below are examples of custom words and their spoken forms, seen in the Vocabulary Editor:
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Deleting “Words” and Modifying Word Properties

If you encounter a word or phrase that Dragon does not transcribe as you would like, remember that it might
warrant a spoken form or longer entry in the Vocabulary and Dragon may need to learn about how and how
frequently you use it therefore you want to have Dragon analyze relevant text and run Accuracy Tuning (see
the Accuracy Center). Also, particularly if the pronunciation contains non-English sounds, you may want to
provide some acoustic “training”—see "Training Words".

You may also run into cases where a word you need is consistently transcribed as another word. If that other
word is not important to you, deleting it from your profile’s active Vocabulary will solve the conflict by
removing your desired word’s “competition.” For instance: the names Schaeffer, Shaefer, Schaefer and Shafer
all sound alike, so if you want Dragon to write “Schaefer” but it typically writes “Shafer” even though you have
already corrected the error, you may want to delete “Shafer” from the Vocabulary.

You can do this by finding and deleting the word in the Vocabulary Editor, or you can do it by bringing up the
Correction menu over the undesired word after Dragon transcribed it.
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Note: Dragon’s active Vocabulary comes with literally thousands of entries. As you browse the Vocabulary
Editor, you will see many you are very unlikely to ever about what you are dictate, but don’t spend time
deleting them unless they actually cause a conflict!

There’s more you can do in the Vocabulary Editor! For instance, by clicking its Properties button, you open the
Word Properties dialog, where you can view or change the capitalization, spacing and numeral properties of an
entry.

IMPORTANT Use the Word Properties dialog to modify the Dictation Command “new line” if you want it to

trigger capitalization of the following word. (See the lesson Starting to Dictate.) Similarly, you can set the
ellipsis (dot dot dot) to NOT trigger capitalization of the next word.

In the Word Properties dialog box, you
can also choose one or even two
alternate written forms.

For example, you may want:

the spelling “colour” instead of
“color”,

the spelling “email” instead of the
hyphenated “e-mail”,

the abbreviation “fig.” instead of
the word “figure” just before
numbers, as in “fig. 3”,

the title Professor instead of its
abbreviation.

The Help contains more details. In
particular, take a look at the Help
topics “The Vocabulary Editor Dialog
Box,” “Deleting words,” and “The Word
Properties dialog box.”
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Another example of alternate written form is illustrated below: pre-employment instead of preemployment.

Note: in the Vocabulary Editor, entries whose properties were modified are marked with a “P” icon.
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Key points about the Vocabulary Editor and Properties

 You can access the Vocabulary Editor with a command like edit vocabulary, through the Accuracy
Center, or through the Vocabulary menu of the DragonBar.

 In the Vocabulary Editor, custom-added entries are marked with a red plus sign; choosing Custom
Words Only from the Display drop-down list allows you to see just the custom entries.

 You can locate an item by entering it in the Written Form field. By using the Display drop-down list,
you can also browse subsets like “Custom words only” and “Words containing punctuation.”

 Spoken Forms are an efficient way to help Dragon transcribe “special words.” You can view many
examples of Spoken Forms in the Vocabulary Editor. In addition to clarifying pronunciation (particularly
useful for items that contain digits, symbols, or silent letters), Spoken Forms can be used to allow the
speaker to say something quite different, and much shorter and easier, than their associated written
form: you say just “E O B stat”, for instance, and Dragon types “Explanation of Benefit (EOB)
statement.”

 A Vocabulary entry can have several spoken forms, and can have one or two alternate written forms.

 If a Vocabulary entry you don’t need “competes” for recognition with something you do need to
dictate, you can delete that entry from the Vocabulary Editor (for instance, Cassidy and Cassity). To
see the words that have been deleted from the vocabulary, you can choose “Deleted words only” from
the Display drop-down list.

 You can view or change the special Properties of Vocabulary entries, including spacing and
capitalization. For instance, you may wish to change whether Dragon uses the spelling “travelled” or
“traveled”, whether the ellipsis (dot dot dot) and the Dictation Command “new line” trigger
capitalization of the next word…
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Importing Lists of Vocabulary Entries

You now know how to add words and phrases one by one in the Vocabulary Editor. If you have many entries to
add, this is not the most efficient method, particularly if you already have some relevant lists in electronic
form. Dragon’s Word Import feature (available in editions Premium and above) allows adding many Vocabulary
entries at once, even if they have Spoken Forms.

Observe the sample import list in the illustration below, and identify the motivation behind each entry. You
can then make and import one or more lists of your own, as described below.

To create and import lists of “words”:

Step 1: Create a document (or edit an existing document) listing entries you want to add to the Vocabulary.
You can do it in any word processor as long as you can save this document as plain text.

 Have each entry on a separate line.

 Make sure everything is spelled, capitalized and spaced correctly.

 To include a Spoken Form, follow the Written Form with a backslash character then the Spoken Form:
for example, Grb II\grab two.

Step 2: Save this document as a .txt file (from the File menu, choose Save As and, depending on the word
processor, choose Text Document, Text Only, or Plain Text), then close the file.

Repeat as necessary with other lists. (You may find it convenient to make several lists, such as a list of
friends and relatives, a list of professional contacts, a list of product names, a list of local landmarks,
etc.)
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Step 3: Say import custom words, or use the DragonBar’s Vocabulary menu to pick “Import list of words or
phrases.”

Step 4: On the Add Words from Word
Lists dialog, click the Add File
button.

The Add File window appears. Locate the
file containing your list and click Open;
the name of the file you designated is
now displayed in the File List.

If you have other lists to import, add
their files in the same way.

Step 5: Click Next. The software will
import the listed items into the
Vocabulary.

The imported entries will be viewable in the Vocabulary Editor, where a red plus-sign appears next to them
(like for entries that were added by means other than an import list).

TIP: From the Vocabulary menu, you can also export all custom-added words into one txt file. This is useful

for safe-keeping or for import in other user profiles.

Note:

 In Dragon 12’s edition Professional and above, you can choose .xml as an export format so that Word
Properties will be captured.

 In the file that results from the export in Dragon 11 or 12, there are two items of note: a first line (the
header @Version=Plato) is added automatically and spoken forms are separated by two backslashes
instead of one. If you want to import such as file (as opposed to importing a file you made yourself), do
not remove the header line and do not replace “\\” with “\”.

 Exported word lists do not include trained pronunciations.

Key points about importing Vocabulary lists:

 You can add whole lists of Vocabulary entries at once. Prepare the list(s), then open Dragon’s list
import dialog (you can say import words, or choose from the Accuracy Center or the DragonBar’s
Vocabulary menu).

 Word lists must be saved as plain text, and closed, before they can be imported.

 Each word list entry must be on its own line.

 To specify a spoken form in a word list, use a backslash (\) to separate it from the written form.

 You can also export all custom-added words into one file (in .txt or .xml format). This is useful for
safe-keeping or for import in other user profiles.
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Customizing the Vocabulary from Existing Documents

You now know about importing lists of entries into the Vocabulary. Another efficient way to boost your
accuracy is to let Dragon analyze text that is similar to what you are likely to dictate: the Add Words From
Documents tool use many documents at once to “harvest” potential words to add to the Vocabulary, as well as
to “adapt to the writing style” (i.e., learn frequency information). The greater the amount of relevant text
Dragon gets to analyze, the better it can adapt its Vocabulary to what you usually need to dictate. (This is
similar to giving a just-hired transcriptionist many documents in which to observe the terms used, their
spellings, the words that often appear before or after, etc.; doing so would help the transcriptionist get ready
to transcribe your dictations most accurately, right from the start.)

Dragon can perform its text analysis on files of the following types: .txt (plain text), .rtf (Rich Text), .doc(x)
(Microsoft Word), .wpd (Corel WordPerfect), and HTML formats.

TIP If significant text exists only in an application that doesn’t normally produce files of these types

(PowerPoint is an example), see whether this application lets you copy text so you can paste it in the
DragonPad and save it from there, or whether it offers a way to extract plain text (it could be called “export”
or “save as outline” for instance.) Also, if essential text only exists as PDF or in paper form, consider using
Optical Character Recognition software such as OmniPage to convert into one of the accepted formats.

Step 1: Locate some electronic documents you have written—think of reports, letters, memos, proposals... (As
long as they are similar to what you intend to dictate, you can also use documents written by someone
else.) The more closely these documents match the dictation you will usually be doing, the better.

Step 2: Spell-check the documents if necessary (since Dragon would detect misspellings as unknown words.) In
addition, remove any foreign-language sections that might be present. Then, make sure the
documents are closed. The Help contains more details on this tool, including how to best prepare
documents for analysis.

Now that you have texts similar to your intended dictations, let’s designate them for analysis. (If you
obtain more documents later, you can designate them to Dragon at that time.)

Step 3: Say "switch to DragonBar", then "vocabulary" to open the menu, then "learn from specific
documents."(There are other ways to do, by voice or by hand.)

Checking the box “Adapt to writing style”
will make Dragon learn frequency
information, which increases accuracy since
it helps differentiate between homophones
like “world” and “whirled”.

Leave this box checked unless you only want
to “harvest” potential custom words—for
instance, if the text is very different from
your normal style, or contains a foreign
language.
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Step 4: On the Add Documents box, click Add Document. On the resulting window, locate and select the
relevant document(s), then click Open.

TIP You can select multiple

files at once by holding down the
Ctrl key or by pressing Ctrl A (the
Windows keyboard shortcut for
“select all”).

Dragon will now analyze the text contained in the designated documents. This may take a moment—if
there is a lot of text to analyze, you should run this tool when you do NOT need to use Dragon for
something else. Once Dragon indicates that the analysis is complete, click Next.

Dragon will then present you with a list of the “unknown” words it found, with a checkbox next to each
one, and the number of times each word was encountered (the words found most frequently are
presented at the top since they are most likely to be relevant, unlike those that only occurred a few
times.)

Step 5: Uncheck items you do NOT wish to add. (If the list is long, using the Uncheck All button will save you
time.)

TIP This list may include capitalized forms of common words (such as ‘Trainer’); these are usually

better left out of the Vocabulary since you can always say “cap” before a word (or capitalize after the
fact, thanks to “capitalize <xyz>”), but you may want to add to the vocabulary phrases that contain
them, such as ‘Senior Technical Trainer’ (remember, it’s a good idea to add to the Vocabulary the
phrases you usually want capitalized).

Step 6: Edit items as warranted: if you wish to modify an item (to make it lowercase, or expand on it, for
instance) or to give a spoken form to an item, make sure it’s highlighted then click Edit.

This opens the Edit Word window, which also presents a little context for the item.
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Once you click Next, Dragon gives you the option to provide acoustic training for the selected words. Feel free
to take this opportunity to pronounce them, but know that you can skip this step and provide training later just
for those words that seem to need it, as explained in this workbook and the Help.

Finally, Dragon will adapt its word-frequency and context information based on the text analyzed (unless you
unchecked the box “Adapt to writing style” on the first screen of this tool); this will allow it to better choose
between words that sound alike.

Key points about customizing the Vocabulary from documents:

 The analysis of specific documents is accessible from the Vocabulary menu and the Accuracy Center.

 This tool can analyze existing documents to learn about the “writing style” you plan to use—meaning,
which words are used with what frequency, and which words appear near each other. It’s OK to use as
input text written by someone else, if it’s reasonably similar to what you plan to dictate.

 To be used in this tool, files must be text files (see the type list in the Add Document window).

 The tool can process many files at a time. You may wish to re-run it whenever you create or find
suitable text. The more (relevant) text is processed, the more refined your profile can become.

 When presented with the unknown words the tool found, you can choose which ones to add. Thanks to
the Edit button, you can modify their spelling as well as give them a Spoken Form if warranted.

 After adding to the Vocabulary items you are likely to dictate, letting Dragon analyze text that contains
them helps pre-empt recognition errors.

 Analyzing specific documents is only one of the ways Dragon can adapt; you can learn other ways in
this workbook as well as in the Help.
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Customizing the Vocabulary from Your E-Mail

As you learned, Dragon can adapt its Vocabulary based on designated documents. It also has the ability to
quickly learn from your usage of several e-mail programs: Lotus Notes, Microsoft Outlook, Outlook Express, and
Windows Mail. By “studying” the e-mails you sent as well as the recipient names, Dragon can identify
potentially useful contact names to add to the Vocabulary, as well as adapt its statistical information on word
usage (frequency and context). This will help it transcribe your dictations more accurately.

You should take advantage of this tool as soon as possible after creating your User profile.

Step 1: Say open Accuracy Center, then say or click the link Increase accuracy from e-mail.

Step 2: The tool will detect supported e-mail programs installed on your computer and display their names
(this may take a moment). Check the checkbox of the program(s) you want Dragon to analyze.

Step 3: Use the checkboxes to indicate whether you want Dragon to only look for contact names to potentially
add to the Vocabulary, or whether you also want Dragon to adapt its statistics based on your sent mail.

The checkbox option to “Improve
from my e-mail writing style” will
adapt the statistical language
model; it is recommended EXCEPT
if what you sent in that email
program contains another
language.

Note: The analysis may keep
Dragon busy for a while, especially
the first time. Later on, it will go
much faster if you choose the
option button “Consider e-mail
written since my last scan.”

IMPORTANT When you start this process, your e-mail program may bring up a message box for you

to allow Dragon to access it. If you have several windows open, this message may be hidden under
another window. Note also that the process may take quite a while if there are many emails to
analyze.

Step 4: After its analysis, the tool will display what it identified as potentially useful additions.

The rest of the process is similar to the analysis of specific documents: you can uncheck items
(individually or all at once), edit items, and train items acoustically if you wish, then Dragon adds to
the Vocabulary the checked items -- plus it adapts its language model to the “writing style” (word
frequencies and word sequences observed), if you opted for that.



Copyright  2013 Nuance Communications, Inc. All rights reserved 41

Key points about customizing the Vocabulary from e-mail:

 Dragon can quickly adapt its Vocabulary from your use of certain email clients installed on your
computer,thanks to a tool available in its Vocabulary menu and Accuracy Center.

 This tool performs two functions: it finds and lists potentially useful contact names to add, and it also
analyzes your sent e-mails to “adapt to the writing style”, i.e. to refine the word usage information in
the Vocabulary’s Language Model.

 As for document-analysis, when presented with the list of potential items to add, you can choose to
check all, uncheck all, and edit any of the items: click the item, click the Edit button, then modify as
needed.

 Use this tool as soon as possible after creating a profile, then every few weeks so that Dragon can
adapt your profile from the emails you most recently sent. (After the first time, the process will be
quick.)

 Remember that Dragon needs to “know about” your contacts in order to transcribe their name
correctly—this is particularly important for shortcut commands such as “email the selection to…” and
“schedule meeting with…” (supported in Microsoft Outlook).
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Starting to Dictate: Controlling the Microphone

When ready to dictate, you must ensure that Dragon NaturallySpeaking is able to hear you. Your microphone
must be connected and positioned correctly of course, but the software also needs to know whether to
“listen”. This lesson shows several ways to turn Dragon’s microphone or on off, and introduces the DragonBar.

Note: If you are using a Bluetooth microphone, make sure that it is not only powered up, but also active (that
is, in “call mode”). On the Plantronics Calisto microphone, this is achieved by pressing the headset’s button.
Please see your microphone’s user guide for details, including how to charge the headset and how to pair it
with the dongle if necessary.

The DragonBar and the Microphone Icon

In Version 12, the DragonBar is docked to the top of the screen by default. Be sure to explore, in the Options
dialog’s View tab, the various ways that you can modify the DragonBar’s appearance to suit your preferences.

If you choose “Floating”, the DragonBar will be narrower but thicker than when docked to top, and you can
move it anywhere on your screen; to drag it, position your mouse over the DragonBar’s titlebar or over its
“handle” (the gray vertical lines at left.)

Right-clicking the DragonBar brings up
its contextual menu. From there, you
can say View options to open the
Options dialog directly on its View tab,
you can exit Dragon, and more.

TIP: Saying Show titlebar toggles the

titlebar on or off. If you like the
Floating display but want to save
vertical space on your screen, you may
wish to toggle off the DragonBar’s
titlebar.
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Note: If you set the DragonBar to "Always on top", it will cover secondary Dragon windows, such as the
DragonPad and Help screens.

For more details (including using voice commands to switch the DragonBar in and out of “Tray Icon only”), see
the Help. Remember that you can quickly search Dragon’s Help by voice by naming one or more search words
or phrases, as in, for instance: “search Dragon Help for DragonBar display.”
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The DragonBar includes several menus, a message area, and a microphone icon which is horizontal when the
microphone is off. If you click this icon, it becomes vertical: the microphone is on. You can now click the icon
to turn the microphone off. This is just one way to control whether Dragon can listen or not.

Below is a screenshot of the Floating DragonBar, with its titlebar off and the microphone turned on.

TIP The microphone icon is also available in the system tray (on the Windows Taskbar, usually in the lower-

right near the time display). You may want to check that your operating system does not hide it among other
icons. (The illustration below is from the Notification Area Icons section of the Control Panel in Windows 7.)

Note: If you like to keep the DragonBar minimized as a Tray Icon only, Dragon 12 lets you display its content by
voice command as well by right-clicking the icon: say "open Dragon’s tray menu.”

The Microphone’s Commands and Sleep State

One can turn off the microphone by saying the command microphone off. There is no command to turn the
microphone on given that, when the microphone is off, it can't “hear” anything! There are, however,
commands to put the microphone in and out of a “sleeping” state where it doesn’t transcribe your words but it
is still listening. To try this, turn the microphone on by clicking on its icon, then say stop listening or go to
sleep.

IMPORTANT For these and all voice commands, there should be a brief silence before and after, but

none in the middle, otherwise the program cannot recognize the command and instead transcribes the words.
For example, make sure you say the words “go to sleep” together in a natural flow, not “go… to… sleep”.
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Putting the microphone to sleep is useful when you need to "put on hold" Dragon for a moment. However,
leaving it in that state for a long time is not recommended, so do turn the microphone off if you will not be
dictating for a while (and are physically able to turn on the microphone manually.)

TIP You can set Dragon to have the microphone asleep when your profile opens, waiting for your command to

“wake up”, so that no manual action is needed to turn the microphone on. To set this option by voice, say
“open Dragon options” then “click Miscellaneous” then “click Have the microphone on but asleep."

The Importance of Hot Keys, including Microphone On/Off

Pressing a key or two is usually quicker than moving and clicking the mouse (and physically easier, too)—
software programs, including operating systems, typically contain keyboard shortcuts, or ‘hot keys’. Dragon
provides hot keys for various useful tasks, including controlling the state of its listening.

If your computer has a full-sized keyboard, press the plus (+) key on the numeric keypad (on the far right of
the keyboard). Pressing this hot key turns Dragon’s microphone on, and then pressing it again turns it off.

If your computer does not have a numeric keypad, or you wish to keep the plus key for other use, designate a
new key to serve as the microphone on/off hot key. This is done through Dragon’s Options dialog box:

Step 1: On the DragonBar, click Tools, then Options (you can also say open options dialog). Click the tab
labeled Hot Keys (you can also say click Hot Keys).

Step 2: Click the button Microphone On/Off. A window
entitled Set Hot Key appears.

Step 3: Press the desired key (or key combination), then
press Enter. F10 is typically a good choice.

(If the hot key you pressed is already assigned in
another application, Dragon will let you know.)

Step 4: Back in the Options dialog box, click Apply, then OK.

Note: Dragon also offers a hot key to toggle the microphone between sleep and listening.

IMPORTANT: When using the Remote Microphone app as your source, you cannot to use Dragon’s

microphone button on the DragonBar or the tray icon, or the microphone hotkey. You must tap the app’s
microphone icon, or use the sleep commands. Also, you may wish to disable your device’s auto-lock feature (or
set it to a longer time).
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Key points about controlling whether Dragon “listens”

 Dragon “listens” whenever its microphone is on. Remember to turn the microphone off (or put it into
its sleeping state if appropriate) when you are not dictating, like before answering the phone, speaking
to someone, or clearing your throat; this is a simple but important habit you should develop quickly.

 Pressing its hot key is usually the fastest and most convenient way to turn the microphone on and off;
you can also click the microphone icon on the DragonBar or in the System Tray.

 You can change any of Dragon’s default hot keys, including the microphone’s, in its Options dialog (say
open options dialog, then click hot keys).

 You can turn the microphone off by saying microphone off, but then the mouse or keyboard need to be
used to turn it back on. You can say go to sleep or stop listening to put the microphone into a sleeping
state and then say wake up or listen to me when you wish to dictate again.

 Microphone off, stop listening, go to sleep, listen to me and wake up are voice commands. In order
for Dragon to recognize and execute the desired action, you must pause slightly before and after but
not in the middle of the command.

 When using the Remote Microphone app as your source, you cannot to use Dragon’s microphone button
on the DragonBar or the tray icon, or the microphone hotkey.
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Starting to Dictate: Your First Dictation

You can use Dragon NaturallySpeaking to dictate into virtually any Windows application. Further in this
workbook, you will learn how to start programs by voice (but one doesn’t need to have started a program by
voice in order to dictate into it.)

What you dictate will be inserted wherever your insertion point (cursor) is located in your document. There are
many ways of moving the insertion point by voice, but know that you can also re-position it by hand (clicking
the mouse where you want it, or using your keyboard’s arrow keys) just as you normally would.

TIP Before dictating, make sure the desired window is active (its title bar should not be dimmed), and the

insertion point (vertical bar) is where you want your dictation to appear. (Your operating system can make such
visual elements easier to see. For example, Windows XP’s Accessibility Wizard, under Start > Programs >
Accessories, walks you through various items that can be helpful, such as increasing the thickness of the
insertion point.)

Dictating Text and Punctuation Marks

Here are the most common punctuation marks, followed by what you say to “voice-type” them:

. period (or full stop)

, comma

? question mark

! exclamation point or exclamation mark

: colon

; semi-colon

For these exercises, start a word processor (for example, you can say start DragonPad).

Exercise 1: Look at the following sample, dictate it, then say microphone off. (If any word is misrecognized,
ignore it for now.) The very first words may take a moment to appear on the screen; this is normal.

How is this different from dictating to a person? I should try to provide clean input: speaking
naturally, but without mumbling or trailing off!

CAUTION Do turn off your microphone when you finish dictating! If your last sentence reads something

like “trailing off! Microphone off", you probably forgot to pause briefly before giving the command. (If you
cannot use your hands, say “go to sleep” or “stop listening” instead of “microphone off.”)

New Line and New Paragraph

With Dragon active, you can press your Enter key, but you can also simply say the commands new line and new
paragraph.

Note: When you start dictating your new paragraph, Dragon will capitalize its first letter automatically, just
like it automatically capitalizes after a period, an exclamation point, or a question mark. By default, Dragon
does NOT capitalize the first word after new line or colon.

TIP If you prefer new line to trigger capitalization, you can change its default via the Vocabulary Editor,

since new line belongs to a special group of commands accessible there; these so-called Dictation Commands,
such as “cap”, “caps on” and “numeral”, appear near the very top of the Vocabulary Editor’s list, with a
blank Written Form field. To find them quickly, change the Display drop-down list to “Word with spoken forms
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only”. Once you’ve highlighted new line in the Vocabulary Editor, say or click Properties, then choose
“capitalized” from the drop-down list “Format the next word”.

The Results Display and its Options

Exercise 2: Study the following text sample then dictate it in a blank document. (Ignore any errors for now.)

The more I use it, the software will adapt to the way I sound and the words I use. At the same time,
I will also acquire good habits like pausing optimally, keeping silent when hesitating, and turning the
microphone off, or putting it into its sleep state, when necessary!

As you dictate, a small “rolling” Dragon icon appears, indicating that recognition is in progress.

If the option “show preliminary results” is enabled (on the View tab of the Options dialog), you will instead see
the following as in version 10 and prior:

 Your words first appear in a small horizontal rectangle. This is called the Results Box.

 Words accumulate in the Results Box until you pause, at which point they appear in your document. If
many words are dictated without a pause, the Results box automatically stretches out.

 The contents of the Results Box sometimes change as you speak; what first appears there may not be
what is inserted in your document, since Dragon sometimes revises its original guess based on
subsequent words.

Dragon uses the everything it hears between two pauses to best choose what exactly it should transcribe; this
is particularly important for words that can be spelled in different ways, like “to” and “too”. If you speak
single words, or only a few words at a time, the software has few or no contextual clues. For this reason, long
continuous “utterances” can be recognized more accurately than short ones (and long words better than short
ones).

IMPORTANT Try to formulate your sentences and commands before you start dictating them. This can be

challenging at first, particularly for those who have been “thinking through their fingers” for years, but you’ll
develop the habit once you see what a difference it makes.

Exercise 3: Dictate a paragraph of some four sentences on today’s weather. (For now, ignore any errors.)
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Did you forget to dictate punctuation in this paragraph? It can be harder to remember when we are “composing
out loud” but, with practice, it will become second nature.

TIP You can take advantage of Dragon’s option to automatically insert commas and periods as you dictate—

see Auto-Formatting under the DragonBar’s Tools menu. The Help contains details about this “Natural
Punctuation” option and the commands to turn it on and off.

IMPORTANT The location and behavior of the Results indicator can be customized from the Options

dialog’s View tab. Many users find it most convenient to “anchor” the indicator to a place where it’s unlikely to
hide anything, such as the bottom right corner of their screen; to do that, just check the “Anchor” checkbox,
close the Options dialog, then drag the indicator to the desired place.

Below are other frequent punctuation marks—you may want to say them out loud once before the next
exercise. Note in particular the ellipsis and the difference between dash and hyphen.

Remember that you can use the Vocabulary Editor to see punctuation and symbols with their existing spoken
forms, as well as to add your own spoken forms, and to modify properties (such as “having no following space”
like the open quote.)

“ open quote

” close quote

( open paren or open parenthesis

) close paren or close parenthesis

… ellipsis or dot dot dot

& ampersand or and sign

-- dash

- hyphen

TIP You don’t always have to say hyphens: thanks to its built-in Vocabulary, Dragon can automatically

include hyphens in items such as 3-year-old, above-mentioned, after-tax, ad-libbed, ankle-length, anti-
infective, as well as famous hyphenated names like Abdul-Jabbar. (To see many, you can choose “Words
containing punctuation” in the Vocabulary Editor’s dropdown list “Display”.)

You can prevent Dragon from entering a hyphen by pausing or saying “spacebar” where the hyphen would be.

Exercise 4: Dictate the following sample. (If any recognition errors occur, ignore them for now.)

These lessons remind me that "practice makes perfect." (Who said this, Confucius?)

When it comes to speech-recognition software, truer words were never spoken…

TIP At the moment one turns off its microphone off, Dragon may still be working on the last sounds it heard.

Key points for your first dictation:

 What you dictate is transcribed at the insertion point (the blinking vertical bar), the place where
characters would appear if you started to type. Before you dictate, make sure that the desired window
is not just visible, but also has the focus.

 To modify how Dragon indicates that recognition is in progress, use the View tab of the Options dialog
(to bring up this dialog, you can say open Dragon options). To avoid situations where the Results
indicator (icon or stretching box) prevents you from seeing something on your screen, you can "anchor"
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it (check the “Anchor” checkbox, then close the Options dialog and drag the indicator to the desired
place). You can also change how long it remains on the screen.

 Speaking in longer, continuous phrases provides contextual clues and thus helps Dragon choose
between homophones like “right” and “write” or “to” and “two”.

 Punctuation is part of the dictation context—it has an impact on recognition accuracy.

 Two very frequent Dictation Commands are new paragraph (which creates a blank line) and new line.

 By default, new line does NOT trigger capitalization of the following word; you can change that
through the Vocabulary Editor’s Properties dialog.

 Your very first dictated words may take a moment to appear on the screen. This is normal.
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Dictating Prices, Units, Dates, Times, Addresses…

Dragon NaturallySpeaking follows spacing and capitalization rules: for example, it inserts a space after comma
but none before, and it capitalizes at the beginning of sentences and paragraphs.

In this lesson, you learn about contextual automatic formatting that allows you to naturally dictate prices,
times, dates, abbreviations, contractions, units of measure, street addresses, e-mail addresses, URLs, ISO
currency codes and other special text. You also learn about Spell Mode and other recognition modes.

Automatic Text Formatting During Normal Dictation

On the Auto-Formatting Options dialog (available from the Tools menu), you can turn Dragon’s rules of
automatic formatting off and on, as desired. For example, you can choose to have Dragon:

- Transcribe numbers greater
than two as numerals. (By
default, Dragon follows the
rule that small integers should
be written as words unless in
contexts such as a unit or
address.) Use the drop-down
list on this dialog.

- Expand contractions (such as
“won’t” and “didn’t”).

- Insert two spaces after
periods.

Please see the Help for details.

TIP The Vocabulary Editor’s Word

Properties dialog offers related
capabilities. It lets you obtain
contextual formatting: you can ask
that numerals always be used after a
particular word (as in “version 4”) and
you can set alternate written forms
(for instance, if you prefer “figure” to
be written “Fig.” before numbers, as
in “Fig. 3”).

Note: The Vocabulary Editor also lets
you change the properties of Dictation
Commands (for instance, you may wish
“new line” to trigger capitalization,
as “new paragraph” does).

Please see Vocabulary Customization.

Exercise 1: Dictate some phone numbers with and without area code. (No need to say "hyphen".)

Please call 607-585-3926 instead of 587-1239. Toll free directory: 1-800-555-1212
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TIP By default, Dragon applies its automatic formatting rules even if you pause within the segment (the

option “Allow pauses in formatted phrases” lets you turn this off.) If you need to dictate sequences of 7, 10
or 11 digits and do NOT want them formatted as phone numbers, one trick is to say “numeral” just before.

Exercise 2: Dictate the following address. For the line containing the zip code, just say Oakland California 9
1 2 3 5; Dragon automatically uses the postal abbreviation for the state and precedes it with a comma.

127 Evergreen Terrace

Oakland, CA 91235

Exercise 3: Dictate the following dates. (Dragon automatically formats when you say, for instance, “Monday
July sixteenth 2009”.

TIP: You can change the default date format to one of those offered on the Auto-Formatting options dialog.

Monday, July 16, 2009 10/15/09 (say slash) 12-7-2013 (say hyphen)

Exercise 4: Dictate a few sentences containing prices, including the one here. (Say four dollars and ninety
cents; Dragon will automatically format it with the dollar sign and dot.)

Suggested retail price: $4.90

Exercise 5: Dictate the following sentence, or a similar one containing a URL. Pronounce the URL w w w dot
the best business dot com. Dragon will automatically remove the spaces between words.

Please visit www.thebestbusiness.com for more information.

Exercise 6: Dictate the following e-mail addresses. (Remember: for e-mail addresses you frequently dictate,
adding them to your vocabulary will ensure that you can dictate them quickly and with high accuracy.)

Laura_Miller@domain.com (say “Laura underscore Miller” and “at” or “at sign”)

customerservice@electricalexperts.com (“customer service at sign electrical experts dot com”)

The Restricted Recognition Modes

There may be times when you want Dragon to recognize less than it normally does. You may want to speak only
commands, or enter many numbers or characters in a row—when inputting figures or product codes into a
database, for instance.

Take a moment to explore Dragon’s restricted recognition modes, which include Numbers Mode, Spell Mode,
Command Mode and Dictation Mode. (Please see the Help for details beyond the ones below.) Note: Dragon
includes a persistent indication of the current recognition mode on the DragonBar (next to the Full Text
Control checkmark).

TIP Dictation Mode can be helpful if you want to dictate as quickly as possible.
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Numbers Mode -- Dictating Numbers Exclusively

When you are about to dictate a sequence of numeric data, consider switching to Numbers Mode. When in this
mode, the software tries to recognize everything it hears as number-related (or as a command).

Step 1: Say numbers mode on or choose Numbers Mode from the DragonBar’s Modes menu. (Notice the status
message in the DragonBar.)

Now that Dragon is in Numbers mode, you can:

 dictate numbers and punctuation (hyphen, dollar sign…). For decimal point, say dot or point.

 say new line, new paragraph and space

 say move up|down|left|right <number> to move the focus to another line, cell, or item.

Step 2: To resume regular dictation, you can say a command such as switch to normal mode, or use the Modes
menu.

Spell Mode -- Dictating Letters, Digits, and Other Characters

The Spell Mode is useful for dictating character sequences which don’t form pronounceable words, as is often
the case for part numbers, license plate numbers, codes, usernames and passwords… It’s also useful for
spelling out terms which you anticipate Dragon won’t know, such as words in a foreign language or unusual
product names. Of course, if you plan to use these words or phrases more than once, you should add them to
the Vocabulary, with spoken form if warranted.

Step 1: Say Spell Mode on or Switch to Spell Mode. The DragonBar will indicate that Spell Mode is on.

You can now dictate characters, including letters, digits, and symbols, as well as spacebar.

 To capitalize a letter, say cap immediately followed by the letter.

 As in Numbers Mode, you can use the move <direction> <number> commands to navigate. You can
also say space. (Dragon will not automatically handle spacing as it usually does.)

 You cannot use new line or new paragraph, but you can say press Enter.

Step 2: You can return to normal dictating by voice (Spell Mode off…) or by hand (Modes menu> Normal Mode).

TIP The Help topic “Spelling Characters” contains the list of possible pronunciations, including the alpha-

bravo-charlie alphabet and accented characters like “n tilde” and “alpha umlaut”. When spelling out, you can
also say “oh” instead of “zero”.

The Spell Command -- Dictating characters within Normal Mode

IMPORTANT If you need to dictate a sequence of characters in the middle of normal dictation, the Spell

command is usually faster than switching in and out of Spell mode: while in Normal Mode, you can say “spell”
immediately followed by a sequence of characters (digits, letters, symbols, and space or spacebar). See the
Help for details.
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This can also be useful in cases where you want to put on the screen a word that would normally be
interpreted as a symbol or a command. For instance, if you wanted to be sure that Dragon types the word
“comma” instead of the character comma, you could say “spell space C O M M A”. This is also useful for the
word “cap” which is also a Dictation Command (to trigger capitalization of the following word): say “spell
space C A P.”

Exercise 7: Dictate “access code: 75Zq/7”, then practice with character sequences of your choice. (Pause
briefly after the colon, then say “spell 7 5 cap zee cue slash 7”. Try to not pause at all during the sequence;
if you paused, just resume by saying “spell” immediately followed by the rest of your sequence.)

Key points about dictating numbers and special text

 Dragon can format dates, times, prices, street addresses, phone numbers, Web addresses, units of
measure, and other special text automatically. The Auto-Formatting options dialog (from the Tools
menu) lets you turn these built-in rules off or on as desired. Also, the Word Properties dialog lets you
adjust spacing, capitalization, abbreviations (such as Gen. for General) and other alternate written
forms (such as “honour” and other spellings used in Canada). In version 12, Dragon reaches out to you
through its Smart Format Rules box when it detects that you made a change that might warrant
adjusting one of its format-related settings.

 The restricted recognition modes can make dictating special text more efficient. They are accessible
by voice commands (“Numbers Mode on”, “switch to Normal Mode”) and through the DragonBar’s
Modes menu.

 Dictation Mode can be helpful if you want to dictate as quickly as possible.

 If you will be dictating only numbers and punctuation, consider turning Numbers Mode on.

 If dictating a long sequence of characters (letters, digits, punctuation, symbols), consider Spell Mode.
The Spell command is good for short sequences which you can say all at once, without pausing, such as
“spell space T W O”.

 When spelling out, you can use alternate pronunciations for the letters (such as alpha, bravo, etc.) and
insert a capital letter by saying cap just before the letter. You can also say space or spacebar. (In
Spell Mode, Dragon doesn’t handle spacing as it usually does.)
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Correcting Dragon’s Errors in Your Dictated Text

Human beings sometimes can’t recognize words correctly—especially if the speaker and the listener come from
different regions, if the speaker is discussing an unfamiliar subject, or if the words are not well articulated. In
addition, when we hear a word for the first time, we may not know how to spell it. Some people’s first or last
names can be spelled different ways (like Gene/Jean, Hansen/Hanson).

This is also true for Dragon! The software uses contextual clues and statistical information to guess what to
transcribe, but sometimes cannot guess correctly. In particular, it may not recognize uncommon words on the
first try, and instead types something that was likely according to its statistics. It cannot recognize and
transcribe a word it has never seen.

Fortunately, in addition to optimizing acoustic factors, taking advantage of the vocabulary customization tools
and using proper correction techniques will significantly reduce the number of errors. Dragon’s Help contains
many details about the different ways to perform it, including by keyboard.

You can choose when to perform corrections. If you look at your screen while dictating and you notice that
Dragon just got a word wrong, it's usually best to finish your train of thought before you correct that
misrecognition: you may want to at least finish your paragraph. That being said, if the misrecognition affects a
word which is likely to appear many times in your document, it's a good idea to correct it as soon as possible.

Handling multiple matches in your text

Dragon 12 lets you directly address a specific word or phrase in your text. When you give a command such as
“correct <xyz>” or “bold <xyz>” or “delete <xyz>” or “capitalize <xyz>”(<xyz> being the word or phrase to
address) and Dragon finds several matches, Dragon places a number next to each match.

You can then say the number of the desired one.

If you wish to affect all matches at once, you can say “choose all”. (If you want the numbers to disappear, say
“cancel”, click your mouse, or just keep dictating.)

Saying “undo that” undoes the change for just the last instance of <xyz>. To undo the change to all instances,
say “undo all".

Note: “Choose all” cannot work for “select” or for “insert before/after”. If you wish to replace several
instances, you may want to explore your application’s capabilities for replacing, including specific
capitalization (the illustration below is from Microsoft Word 2010).
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IMPORTANT: In Dragon’s commands, <xyz> represents the relevant segment on the screen (which could be

more than one word and could include numbers or punctuation marks). When you give the ‘correct <xyz>’
command, be sure to say what appears on the screen, not what you had intended.

Note that when performing a correction, it can be useful to provide some context for the word(s) in error: for
instance, to correct "a" in the phrase "Carol sent a request," you may want to say “correct sent a” or "correct
sent a request."

The Correction Menu: the default interface

By default, when you say a command starting with the word "correct,” Dragon brings up the Correction Menu,
which lists alternative transcriptions as well as a few of the commands you may wish to say. In the example
illustrated below, the speaker said “correct Madison.”

 If what you had said is in the list, you can
pick it by voice (say "choose" and its number)
or by hand (click the desired choice or use the
down arrow and Enter key).

 If it is not, you can click or say "spell that"
which opens the Spelling Window. There, you
can indicate the correct transcription using
voice, keyboard, mouse, or a combination
(see below).

Note that the last item on the Correction menu gives you direct access to the Options dialog’s Correction tab.
(As seen on that tab, another default setting you can modify is Dragon’s opening the Correction menu also
when you use the command “select <xyz>”.)

Correcting in the Spelling Window

Some users prefer the Spelling Window to be the default interface for Correction, so they can act directly when
Dragon’s choice list doesn’t show their desired transcription (instead of having to use “spell that” from the
Correction menu to get to the Spelling Window).

This requires changing one of the options on the Correction tab of Dragon’s Options dialog. Here is one way to
do this: say “open Dragon options”, then say “click Correct commands bring up Spelling Window” (or click
that option’s checkbox).
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With this option set, saying
commands that start with
“correct” opens the Spelling
Window. So does using the
Correction button on the
expanded DragonBar, or pressing
the Correction hotkey (the
numeric minus by default, as
seen in the Options dialog).

As you will see, there are many
ways to indicate in the Spelling
Window what should have been
recognized—including typing, or
spelling out individual
characters, hence the name
“Spelling Window.”

Here is an example. Imagine you dictated "contact colon Madyssen" (note the unusual spelling of this name) but
Dragon wrote “medicine” instead of “Madyssen”. To correct Dragon’s error, you can say “correct medicine”.

The Spelling Window then opens. Take a look at it from top to bottom.
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At its top is what was transcribed, and below is a list of
alternate transcriptions, each preceded by a number.

Here is what you can do:

If what Dragon should have transcribed is listed: say
choose n (the number of the correct line). You can
also pick the correct choice by double-clicking it or
using down arrow and Enter key.

If no choice is quite correct but one is close, you can
save time by modifying it instead of entering it
yourself: click it, or say modify n or edit n. In our
illustration, you could say “edit 1” to bring up
“Madison”, then “backspace 4” then “Y S S E N”.

If what Dragon should have transcribed is NOT listed:

enter it, then say click OK or press Enter. In our
example, you could say “cap M A D Y S S E N” then
“click OK”.

The Spelling Window then closes and, in your text, Dragon replaces the misrecognized segment with what you
indicated was the correct transcription.

Note: In addition to adjusting your document, Dragon also learned a bit of information to refine your profile,
and if you entered in the Spelling Window a word that was not in its active vocabulary, Dragon has now added
that word to its active vocabulary (you could now see that word in the Vocabulary Editor).

Remember that Dragon allows the use of voice and does not prohibit manual action; at different times one may
be quicker or easier than the other. In the edit line of the Spelling Window, it can be faster to make
modifications with mouse or keyboard, although you can perform correction entirely by voice.

You cannot dictate words in the Spelling Window. However, you can dictate:

 Individual characters: letters, digits, space, symbols (see your documentation for details)

 Commands like “backspace 5”, “move right 4 characters”, “delete next word”, “select line”

Note: In the Spelling Window, Backspace and Delete commands should be used instead of scratch that,
especially if Press Key commands are used.

As you enter characters, Dragon presents new choices in the list, so you may not have to enter all characters!

TIPS for spelling out:

 To spell a capital letter, just say “cap” followed by the letter.

 You can use alternate pronunciations to spell letters: “alpha”, “letter alpha”, “letter a”, “bravo”,
“charlie”, “delta”, “echo”, “foxtrot”, etc. (see the Help for the full list)

 To insert a space, say “space” or "spacebar".

 If one of the choices listed is close, you can save time by modifying it: say modify and its number,
which brings it to the top of the Spelling window.
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Exercise 1: Look at the following sample, dictate it, then use the correct <xyz> command to fix any errors.
(This sample was designed to create errors! All the names here could be spelled in different ways.)

Until further notice, the BHDP meeting will be held in room B31 (not B40).

Special invitees this week: Stephen Hess, Anne Petersen, and Gene Wood.

TIP If several consecutive words are incorrect, correct them together. For instance, if "B40” were

recognized as "before tea,” you would say correct before tea.

Exercise 2: Dictate a few sentences containing uncommon words, such as names and nicknames or product
names, until a few misrecognitions appear. For each misrecognition, bring up the Spelling Window and practice
spelling out what you actually said, as well as editing one of the choices from the list.

Using Playback to Aid Correction

Sometimes, especially if you dictate a significant amount of text before correcting, you may not remember
exactly what you actually said. Dragon’s playback feature is very helpful in these instances. You can take
advantage of it in several ways.

If you see that a certain word or phrase appears incorrectly, use the correct command to open the Spelling
Window. Once it appears, click or say Play Back to hear the recording of your voice as you dictated that text.
It may be that in fact you had misspoken or mumbled; this happens to everyone, particularly near the end of
the day! In that case, close the Spelling window (you can say click cancel) and dictate the word(s) again.

TIP You can have playback occur automatically with Correction. On the Correction tab of the Options dialog,

check Automatic Playback on Correction. This is particularly helpful as you first learn to use Dragon; you may
want to turn it off after a few weeks of practice.

If your edition supports it, you can also use Playback to hear sections of dictation in the document itself. To do
this, select the editable text you would like to hear played back. Then, say play that back, or use the
DragonBar’s Audio menu. If you find a misrecognition, you can stop playback by clicking the mouse (or using
the Correction hotkey or button -- see below). Because speech input cannot be received during playback, you
cannot stop playback by voice. If clicking the mouse is problematic for you, play small selections at a time.

Note: You may wish to explore the Playback attributes in the Options dialog.

The DragonBar can be expanded (in supported editions): click its chevron or say view extras bar. To hide the
extras bar, say hide extras or click the chevron again. Its extras bar gives access to several items, depending
on your edition:

 The Correction button opens the correction interface (as do the Correction commands and hot key).

 The playback icons, similar to those on a music player, allow you to begin playback, speed up playback
(useful for large sections of text), stop playback, and skip backwards or forward.

 The Transcribe button launches the transcription of recorded dictations (for details, see the video,
FAQs, and other resources on our website, as well as the Help topics, including the Auto-Transcribe
Folder Agent).
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Exercise 3: Dictate a detailed paragraph about people you know. Then select it and play it back. If you find
any misrecognitions, use the Correction button, hotkey, or commands to correct them.

Note: As you use Dragon more, experiment with how to correct, and when to correct. (We recommend finishing
at least your current paragraph before making a correction, so that you preserve your train of thought.) Notice
what seems more convenient and efficient for you.

Smart Format Rules

When you make a correction related to formatting, such as abbreviations, titles, units of measure, or alternate
written forms, Dragon may display its Smart Format Rules box, offering to change one of its Auto-Formatting
options or Word Property settings. You can then either accept one of the adjustments offered, or dismiss the
box.

If you wish to, you can change settings yourself from the Auto-Formatting Options dialog box or the Vocabulary
Editor, as in previous versions. The Smart Format Rules feature simply "reaches out" to you, making it quick and
easy for you to adjust the settings you care about.

For example: When you dictate “five kilograms,” Dragon writes “5 kg” and if you then change “kilograms” to
“kg” (by overtyping, or using the Correction menu or Spelling window) Dragon presents the Smart Format Rules
box pictured here.

Take a moment to read what the box offers. Then, if you want one of the proposed adjustments to be made,
say “choose” followed by the desired number.

If you don’t want any of the choices proposed, you can say “cancel” or just move on to whatever you would
have done if the box had not come up.
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Key points about correcting recognition errors

 Refining your profile using the features gathered in the Accuracy Center can prevent many errors,
because it helps Dragon become familiar with how you sound and what words and phrases you use
often. Be sure to explore the Vocabulary Editor and add words and phrases (with Spoken Forms
and/or Word Properties such as alternate written forms, as warranted). Beyond that, it’s important
to let Dragon see your custom-added words and phrases in context, for instance by letting it
analyze relevant documents.

 Although correcting misrecognitions may seem time-consuming at first, it will result in increased
accuracy, which in turn means that there will be fewer and fewer misrecognitions to address.

 To have the Spelling window as the default correction interface, the option "Correct" Commands
Bring Up Spelling Window must be enabled.

 Flow is important: commands require a brief pause before and after. Do not pause at all between
the word ‘correct’ and the misrecognized word(s). (At first, you may want to “rehearse” the whole
command in your head before speaking it.)

 When the Spelling Window is open, you can say choose n to pick the correct choice from the list. If
no choice is quite correct but one is close, you can quickly modify it: click it once or say edit and
its number (for instance edit 5). This brings it to the top of the Spelling Window, where you can
edit it by hand or by voice.

 You can use the Spelling window’s edit field to type or spell out words. Note: In the Spelling
Window, you can dictate individual characters (including using pronunciations such as alpha, letter
alpha, etc.) but you cannot dictate words directly.

 To be sure of what exactly was said for the text segment you are correcting, use the Playback
feature. (Another advantage of using playback is that it gives you feedback on how clearly you
dictated.)

 To proofread using Playback, highlight the relevant text then say play that back, or use the
DragonBar’s Audio menu, or click the Playback icon on the DragonBar’s Extras bar. (Not available in
the lower editions.)
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Deferred Correction (editions Professional and above)

As you have learned, correcting recognition errors helps Dragon NaturallySpeaking adapt your profile, which
allows it to transcribe more accurately for you. But what if you have no time to perform corrections before
closing the document you just dictated? In editions Professional and above, when you dictate in DragonPad,
Microsoft Word or Corel WordPerfect, the opportunity is not lost: Dragon can save the audio in synchronization
with the text you dictated, so you can later play it back and make corrections as needed.

This feature also allows you to have someone else correct misrecognitions in your dictated documents—which
means your profile can benefit from corrections refined without any work on your part!

Saving the Recorded Dictation (.DRA file)

Step 1: Dictate into DragonPad, Microsoft Word or Corel WordPerfect. (If you wish to make any corrections
now, do so.) Save the document as you normally would.

(Note for DragonPad users: Because DragonPad doesn’t have an autosave feature, it’s a good idea to
name your document early on and save it regularly.)

Step 2: Dragon asks whether you want to save the associated recording. (Your word-processor’s autosave
feature may even trigger this message for you). If you or someone else will be using Playback or
Correction in this document later, choose Yes.

Dragon then saves, in the same location as your text document, a file bearing the same name, with the
extension .DRA. You may now exit the word processor -- and Dragon, if you wish. You can even shut
down the computer.

TIP By default, whenever a word-processor document is saved, Dragon asks whether you want to save the

recording. In the Options dialog, you can change that setting to always save, or on the contrary, never save.
Recorded dictation files can get very large, so you should only save them if Correction is to take place at a
later time; without the recorded dictation, you can still edit and format the document as usual.
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Step 3: When you are ready, start the application in which you dictated the document and open the document.
You can now use Playback and correct as usual.

Once you have finished correcting misrecognitions in your dictated document, you may delete the associated
.DRA file. (You will no longer be able to use playback on this document but you will still be able to edit and
format the text.)

IMPORTANT When using a .dra file, it is best to proceed in order, from the top of the document.

Note: One of the services an experienced Dragon trainer can provide is establishing optimal options and
workflows including the management of .dra files. This can be particularly useful if another person will be your
“Correctionist.” (See the option “Correction Only” available in the higher editions.)

Making Corrections to Someone Else's Dictation

The Save Recorded Dictation feature allows you to have someone else use Playback and Correction in your
dictated text documents. There are several ways to take advantage of it, particularly if Dragon’s Roaming
feature is used—details are available in the Help and the IT Administrator’s Guide.

The following is an example of third-party correction: Jane has tasked her assistant, Bob, with performing
Correction on her dictated documents, using his own computer.

IMPORTANT: Jane’s profile must be accessible from both computers. If the profile is in a Roaming

configuration, its master copy resides on the network, making the profile usable from any connected computer.

Step 1: Jane dictates her reports. When she is finished, she saves the documents to a network location Bob can
access from his computer. When Dragon asks whether she wants to save the audio, she chooses Yes. If
she wishes, she can now exit Dragon and/or her word processor, and shut down her computer.

Step 2: On his own computer, Bob starts Dragon; when prompted to open a User profile, he chooses Jane's.

Step 3: Bob starts the word processor Jane used, and opens the first report. He is now ready to perform
Correction in this document.

Step 4: Starting from the top, Bob looks for “abnormal” text and highlights it manually. On the expanded
DragonBar, he clicks the Playback icon (Bob should NOT use his voice here.)

Step 5: Watching the screen, Bob listens to the playback. As soon as he hears an error, he clicks the Correction
button or presses the Correction hot key, which brings up the Spelling window.

If not quite sure of what Jane actually said, he uses playback to hear her recorded voice. If the input
is not “clean” (people sometimes make unintended sounds, stumble on a word, etc.), he cancels out of
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the Spelling window and deletes the misspoken segment in the document before typing what was
intended.

If the correct alternate appears in the choice list, he clicks it with his mouse (or uses down arrow and
Enter) then clicks OK.

If the correct choice does not appear in the list, he types it in, then clicks OK or presses Enter.

When he has finished checking the document (and made any additions and/or cosmetic modifications as
warranted), Bob saves it. Now not only is the document finalized, but Jane’s Dragon profile has been refined
through the corrections performed, which will help the accuracy of her future dictations.

The following is only necessary if Roaming is not used: Bob exports Jane’s profile to the network (through the
Manage User Profiles dialog); from there, Jane can import her newly-refined profile.

Key points about deferred correction

 When you dictate in Word, WordPerfect or DragonPad, Dragon can save the recording associated
with your text so misrecognitions can be corrected later, as if you had just dictated it.

 If you choose to save your recorded dictation, you can use Correction and Playback features even
after you close the document: simply start the word-processor in which you dictated the
document, then open the document.

 When saving your document’s recording, Dragon creates a file in the same directory as your text
document; both files have the same name, but the synchronized recording has the extension .dra.

 To be used for Correction, the .dra file must be in the same folder as the document itself.

 Dictation files can get very large, so only save them if necessary. Also, when you are finished
making corrections to a document, you may wish to delete the associated .dra file. (You will still
be able to edit the document normally, and you will save disk space.)

 This feature allows you to postpone Correction, and also to delegate it to a third party—your
assistant, for instance.

 The “Correctionist” must open the speaker’s profile but not speak into it. One can bring up the
Correction interface by clicking the Correction button on the DragonBar’s Extras bar, or pressing
the Correction hotkey (by default, the minus on the numeric keypad; you can change this in the
Options dialog).
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Editing Text by Voice

Dragon NaturallySpeaking lets you use your voice to move around within a document and edit the contents—
whether or not that document was originally created by voice. As you learned, the software transcribes your
dictation wherever the insertion point is. (The insertion point is usually shown as a blinking vertical bar some
call the cursor.)

This lesson presents some of the commands to select text and move the insertion point. Mouse and keyboard
can still be used, of course. Don’t try to do everything by voice unless you have to. At first, focus on getting
optimal accuracy in your dictations — speaking clearly, adapting the vocabulary, performing corrections as
needed, reading a text for acoustic training…

Navigation and Selection Commands

TIP Navigation commands use the words go and move interchangeably, and a space counts as one character.

Some commands move the insertion point regardless of its starting location:

move to top, or go to start of document –- moves to the beginning of the document

move to bottom –- moves to the end of the document

Other commands move the insertion point relative to its present location:

move to end of line (the current line, the one containing the insertion point)

move up(down) 1-20 line(s) or paragraph(s) –- e.g. move up 3 lines

move left(back) 1-20 word(s) or character(s) –- e.g. move left 7 words

move right(forward) 1-20 word(s) or character(s) –- e.g. move forward 3 characters

TIP A space counts as one character.

The insert before/after commands position the insertion point just before or after a specific word or
punctuation mark in the text:

insert before your office –- moves the insertion point to just before the phrase "your office"

insert after Joe comma -– moves to just after the comma following the word “Joe”

The select commands let you “highlight” editable text visible on the screen. Below are just some of them.

You can say select followed by what you wish to highlight (include punctuation as needed):

select let me know select comma obviously comma

Very useful for longer phrases, you can specify a range by naming its beginning and ending word(s):

select do let THROUGH please – "do let me know at your earliest convenience please"

You can select one or more characters, words, lines or paragraphs at a time:
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select line, select next 3 paragraphs, select previous 5 words, select next character… as
well as select rest of line.

Note: You can use similar commands to delete (delete line, delete next three words…) and copy (copy line,
copy rest of line…)

You can also select the entire content of the field or document with the command select all.

You can “unselect” a selection by saying unselect that or deselect that. (Another way is to move the insertion
point with a move right command, for instance.)

TIP As with all commands, you must say these as a continuous phrase, with a brief pause before and after.

For commands that quote words from your screen, choose your target words before you start to say the
command. Otherwise, any hesitation will cause the words of the command to be typed on the screen. (If this
happens, just say scratch that and give your command again, without pausing this time.)

One should always strive to dictate in complete phrases, since context helps the recognition of text. When it
comes to commands, formulating the whole phrase and dictating it without pauses isn’t just helpful, it’s
essential. The exercises below will provide plenty of practice.

Handling multiple matches in text

When you give a command that quotes from your text(such as “insert before <xyz>” or “bold <xyz>”) and
Dragon finds multiple matches for <xyz> (including homophones), Dragon lets you resolve that ambiguity and
even take advantage of it. A number will appear next to each visible match. You can then:

 say the number of the desired instance, or

 say “choose all” (for commands that can apply it)

TIP When the numbers are displayed, the DragonBar’s message area offers a reminder of this instruction.)

Note: In Dragon 12, this match-handling can be disabled from the Commands tab of the Options dialog.

Direct Editing: Bold|Underline|Italicize|Capitalize|Copy|Delete|Cut…

Dragon lets you perform frequent editing tasks quickly: like you can quote from editable text in the commands
select <xyz> and select <start> thru <end>, you can say the verbs bold, underline, italicize as well as
capitalize, immediately followed by the desired word(s). This also applies to copy, as well as delete and cut—
note that these three can be disabled, as explained below.
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IMPORTANT: If these commands

are enabled, Dragon will try to
recognize as one of them any phrase
starting with one of these verbs
followed by a word (or words)
present in the text: e.g. “bold
measures” or “cut corners.” Since
Dragon recognizes commands only if
they are spoken as one flow between
two pauses, this won’t happen if the
phrase is within a sentence or if one
pauses within the phrase, but it
could happen if the phrase is said in
isolation—for instance, if the speaker
is creating a list or had just hesitated
as one often does when composing
out loud. (If this does happen, one
can say undo that.)

Remember in particular the
possibility of unintended recognition
of cut <xyz> and delete <xyz>,
especially if you dictate without
looking at the screen. If you prefer
to avoid this risk, disable these
commands by clearing their checkbox
on the Commands tab of Dragon’s
Options dialog.

*

Full Text Control, “unknown” text fields and the Dictation Box

Commands such as ‘correct <xyz>’ and ‘insert after <xyz>’ (where <xyz> is a word or phrase in the active
text field) work thanks to a Dragon functionality called Full Text Control (formerly “Select-and-Say”). This
functionality requires the text field to let Dragon be aware of its content—such as where words and sentences
begin and end.

Many popular applications build their text fields (or at least most of their fields) in a standard way, and as a
result Dragon has Full Text Control in these fields. However, you may sometimes encounter a text field for
which Dragon cannot have awareness—and therefore Dragon cannot always apply all its normal capabilities.
(For instance, it may not capitalize the first word you dictate in that field.) You may not notice anything
unusual if you just dictate a flow of words, especially if you start with a word that is always capitalized, such
as a name or the subject pronoun “I”. However, if you take actions on the text (such as correcting a
misrecognition or inserting text within a sentence), Dragon may not be able to execute its “<verb> <xyz>”
commands, or adjust spacing as it usually does.

When the insertion point is in such an “unknown” field, the DragonBar’s Full Text Control indicator (checkmark
icon) is dimmed.
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Even in “unknown” text fields, one can use Dragon efficiently—knowing the following:

1. If dictating short entries, you may want to just use what does work in all text fields: dictate normally (most
applications allow this) and, if and when necessary, say ‘spacebar’ (or press the spacebar), say ‘cap’
before a word to force its capitalization (you can also address capitalization after the fact), say ‘move
<left|right|up|down>’ commands or reposition the insertion point by hand, etc.

2. If you want to dictate something substantial, consider using Dragon’s Dictation Box, an intermediary
containing a text field in which you can create, modify, and correct text. (If your edition supports them,
you can even use boilerplate custom commands to paste text.)

When the text is ready, use the
Transfer button: Dragon closes
the Dictation Box and transfers
your text to where you had the
insertion point.

Note: In version 12, by default,
you must say “click Transfer,”
not just “Transfer.”

To open the Dictation Box, you
can:

 Say a command such as
‘Open Dictation Box’

 Use the DragonBar’s Tools
menu

 Use its hot key: Ctrl+Shift+d

IMPORTANT: In Dragon 12, the Dictation Box comes up automatically if you speak where Dragon doesn’t

have Full Text Control. This default can be changed on the Miscellaneous tab of the options dialog.

There is a lot of flexibility around the Dictation Box. In addition to changing its hot key in the Options dialog,
you can:

 Give its command one or more alternate names (from the Command Browser: to find the command,
you can filter for the word ‘box’, with ‘Global Commands’ selected in the Context list).

 Modify its appearance and behavior, via its Settings button: default font size, positioning (anchored, or
near the cursor), whether it shows how many characters it contains…
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TIP: You can have

different settings for
different applications.
Also, you can have
multiple Dictation Boxes
open at one time.

The Help contains more
details.

Replacing and Inserting Words

The select commands are very useful when you wish to change some of the text on your screen. As you would
with mouse or keyboard, you select the relevant segment then you overwrite it by dictating or typing.

For instance, if your text reads "100 Main Street" but you wish to change it to "500 Washington Street", say
select 100 Main (pause) 500 Washington.

TIP For larger passages, take advantage of select line, select <start> through <end>, select paragraph…

The command “resume with…” can also be very efficient as an equivalent of selecting then deleting what you
have just dictated up to a particular word; be sure to read about it in the Help and try it out.

Exercise 1: Practice “overwriting” by voice. Examine then dictate the following paragraph.

I will be in the Boston area for a few days the week after next, and would love to get together for
lunch. We could meet at your office at noon. I’ll be staying at the Madison downtown.

Talk to you soon!

1) Say select lunch  The word “lunch” is now selected.

Say an early dinner  The sentence should now read “get together for an early dinner.”

2) Say select noon
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Say six o’clock  The sentence should now read “We could meet at your office at 6:00.”

3) Say select in through next  The segment “in the Boston area for a few days the week after next” is
highlighted.

Say in your area on Tuesday July fifteenth

Let’s say we now want to add a few words inside this paragraph.

4) Notice the insertion point’s current position. Say insert after dinner, then say if you have time.

5) Say insert before exclamation mark (observe the move), then say comma I hope.

TIP If, after doing some editing in your text, you need to remove trailing white space, you can use commands

such as backspace or delete next character for a single space. You can even say backspace combined with a
number: for example, backspace 5 is like pressing the backspace key 5 times.

Dragon’s many selection and navigation commands can help you quickly edit text—whether or not this text was
created by voice. The exercise below is to be performed entirely by voice, but remember that for optimal
productivity in daily work you may use a combination of voice and keyboard/mouse.

Exercise 2: Look at the following text, dictate it, then edit it by voice as described below.

Dear Ms. Cooper,

It was nice meeting you Tuesday. I think you have some good ideas about the Johnson project! Let’s get the
team focused on this project by February.

When you have time, could you write up your comments and email them to me? I would really appreciate it.

 Edit the first sentence so it reads "meeting with you last Tuesday".

 Edit the second sentence so it reads "You have some great ideas".

 Edit the third sentence so it reads "on this important project".

 Edit the third sentence so it reads "by early February", and insert a blank line after it.

 Change the fourth sentence to “Could you please write up your notes and email them to me ASAP?”

 Edit the salutation, changing "Ms. Cooper" to "Allison".

 Edit the last sentence, removing "really", and add a closing line of "Sincerely, Susan Martin-Smith".

Which commands did you find most useful in each situation?

Key points about editing text

 You can use Dragon to edit a document by voice whether the document was dictated or typed.

 The editing commands can address small or large amounts of text, even several paragraphs or the
entire document (select all).

 At first, uttering the whole command can be tricky for commands that quote words from your text,
such as select… through… and insert before <xyz>. As usual, deciding what you are going to say before
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starting to speak is recommended. If you paused mid-command, just say scratch that, pause, and give
the complete command again.

 The commands that quote your text (select <xyz>, bold <xyz>, correct <xyz>, insert after <xyz>…)
work thanks to a functionality called Full Text Control, which depends on Dragon’s ability to constantly
obtain information from the text field—for instance, where words and sentences begin and end, so
Dragon can apply spacing between words and capitalization at the beginning of a sentence.

 If the text field in which you are dictating is “unknown”, remember that if needed you can say Cap to
start a sentence and spacebar to create a space, as well as use the Dictation Box—an intermediary
window which has Full Text Control: when ready, use its Transfer button.

 In Dragon 12, the Dictation box opens automatically where Dragon doesn’t have Full Text Control. You
can disable this in the Options dialog.

 You can modify the Dictation Box’s appearance and behavior from its Settings button; in addition, you
can modify its hot key in the Options dialog and give its command one or more alternate names.

 You can set the Dictation Box to behave differently depending on the application from which you
opened it.
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Formatting Text by Voice

Whether text was originally dictated or typed, Dragon NaturallySpeaking lets you use your voice to control font
(Arial, Courier…), font style (bold, underline…), font size, alignment (center, right-align…), color, and more.

Note: In order to preserve your train of thought, it’s a good idea to prioritize dictation over formatting: first
dictate your document (or at least finish dictating your paragraph, list, or idea), then revise your words if
needed, and only then apply formatting.

The "X that" Convention

Dragon has many commands to tell the computer to perform a certain action on a certain item. Many are
phrased as "X that", with X being a verb for the desired action: for instance, italicize that and delete that.

Remember, for commands to be recognized, you must pause before and after the command but not within it.

When Dragon hears an "X that" command, it decides what “that” is as follows:

1) If anything on the screen is highlighted (whether by voice or by hand), Dragon performs the action on
that selection. (It can be one or more characters or words.)

2) If nothing is highlighted, Dragon performs the action on whatever you dictated since you last paused—in
n other words, the contents of the Results box, the last utterance.

Note: In Dragon’s commands, you can say “the selection” instead of “that”—as well as “it” or “this.”

Dragon's "X that" editing commands include:

Cap That – capitalizes the first letter of words, e.g. Water Management

(Dragon also has “capitalize <xyz>” as seen in the section on direct editing commands)

ALL CAPS THAT – capitalizes all letters, e.g. EXTREMELY IMPORTANT

no caps that – puts in lowercase all words, e.g. american express

delete that (Dragon also has “delete <xyz>” as seen in the section on direct editing)

TIP To delete your few last utterances, you can repeat scratch that or specify a number of times (for

instance, scratch that 5 times) but the command “resume with…” can be most efficient.

bold that, italicize that, underline that (Dragon also has “<verb> <xyz>”)

restore that – removes all bold/italics/underline formatting from the segment

left-align that, right-align that, center that, justify that

copy that and cut that (you can also use the direct editing commands “<verb> <xyz>”)

paste that

hyphenate that – puts hyphens in the spaces within the segment

compound that – removes spaces between words in the segment

bullet/unbullet that (make sure you are familiar with how your particular application handles bullets)

quote that - puts quotation marks around the selection or last utterance

bracket that (note: in UK English, this inserts rounded characters, not square brackets)
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Note that Dragon also has two special commands for quotes and brackets: you can say "Empty Quotes,"
or "Empty Brackets" to have Dragon insert a pair of quotation marks or brackets so you can dictate
something within them.

TIP The Command Browser’s Keyword Filter lets you explore additional command wordings for the

application(s) you frequently use, as seen in this screenshot. For instance, in Word and WordPerfect, you can
say “turn bullets on” and “turn bullets off” as well as “format that bulleted and bold.”

The "Format That" Commands

Not all formatting commands are worded as "X that", but all follow the same rules about what text the action is
performed on: the selection if there is one, otherwise the last utterance (what was said since the last pause.)

As seen in the Command Browser, the many formatting commands include:

format that bullet style –- bullets the designated text (you can also say set that to or make that bullet style)

format that centered

format that regular

format that strikeout –- places a line through the selection (for example, January 19)

Note that formatting commands can combine several indications, as in:

format that Garamond, format that Arial 12, etc. –- gives the selection the font name/size specified

format that 20 point, format that 12 point, etc. –- gives the selection to the point size specified
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format that bold italics

format that caps bold

format that bulleted and plain

Exercise: Dictate the following to experiment with giving format commands as you dictate and afterwards.

I’m pleased to say I finally read The Grapes of Wrath. It was TERRIFIC! Although it is quite long, I read it
surprisingly quickly.

TIP To undo the last action, say undo that. This is equivalent to Undo in the Edit menu, or the keyboard

shortcut Ctrl z.
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Key points about formatting documents

 The “X that” commands apply to the current selection or, if there is no selection, to the last utterance
(what was dictated since the speaker last paused).

 Remember to pause briefly before and after saying these commands.

 You can repeat delete that or scratch that up to 10 times to delete the last things you said—you can
also say scratch that 3 times, scratch that 7 times… For deleting from the end of your dictation back
to a particular word, the command “resume with…” can be very efficient; we strongly recommend it.

 To undo the last action, you can say undo that (which is equivalent to “press control z”).

 For efficiency, it’s a good idea to prioritize dictation over formatting: first finish dictating (or at least
finish dictating your idea), then revise or correct the text if needed, and only then apply formatting.
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Controlling the Operating System and Applications

Dragon NaturallySpeaking can do much more than type and format your dictated text: it lets you use your voice
to find information, open a specific website, start programs, open desktop items, switch between open
windows, maximize or minimize windows, choose menu and submenu items, navigate dialog boxes, click
buttons, press keys, move or drag the mouse pointer, and more.

Note: If using Windows 8, keep in mind that this operating system introduced some significant interface
changes (such as the “modern” full-screen interface) and Dragon is designed to work primarily in this system’s
“desktop” (“classic”) interface. See this lesson’s section on Windows 8.

IMPORTANT When Dragon is running, it does not inhibit the use of your mouse and keyboard. Mouse,

keyboard, and voice are just three input options. Use whatever is fastest and easiest for you for a given task.

Let’s start with a frequent task made fast and easy thanks to Dragon: searching your computer.

Keyword-Searching the Computer

Available in the higher editions, the “Dragon Voice Shortcuts for Desktop Search” help speed up a process many
of us go through often: finding information we thinkis somewhere on our computer but don’t know exactly
where!

At any time, no matter what is currently active on your screen, these shortcut commands let you launch a
search for items containing the keyword(s) you specify. They use indexing software such as Google Desktop
(freely downloadable from Google’s website).

They have flexible wordings (the Command Browser lets you see all the possible ways to say them) and can be
general (“search computer for <xyz>”-- <xyz> being any word or words) or specific, as follows:

• Search emails for <xyz>: searches for the keyword(s) <xyz> in just the e-mails indexed on your computer

• Search [the] documents for <xyz>: searches just the indexed files

• Search [the] history for <xyz>: searches just the indexed Web pages visited
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Note: These Desktop search shortcuts,
like the Web search shortcuts, can be
disabled or enabled on the Commands
tab of Dragon’s Options dialog. Their
option also controls the Help search
shortcut (“search Dragon Help for…”)

Opening and Closing Programs and Windows

You can use your voice to open any item present on your desktop (including files, folders, and shortcuts): just
say open followed by the item’s name. (You can also use the verbs start, launch or show.) For instance, to
open an item called “winter projects”, you could say open winter projects. (It’s helpful to have names that
are easy to speak!)

IMPORTANT: This works at any time, even if the desktop is not visible. This is a powerful feature, but if

you don’t need it, consider disabling it. (See the checkbox on the Commands tab of the Options dialog.)

Dragon has a similar option for Start menu items: you can start a program or other item that is in the Start
menu by its name. For instance, start DragonPad, open Internet Explorer, start Notepad, start Paint, or start
Windows Explorer. This works at any time, even if the Windows Start menu is not open. Consider disabling this
powerful feature if you don’t need it. (See the Commands tab of the Options dialog.)

TIP Do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2007"? In the Start

Menu (on your Windows taskbar), look under Programs. Whatever the final submenu is called is the name
Dragon may expect--except for popular applications listed in the Help; for these, shorter names are supported.
If you find the listed name inconvenient, you can create a shortcut to the application and rename that shortcut
to something easy; once you have done that, you can also use the easier name to open the application.

To open the Start menu, say click Start or click Start menu. This menu and other menus can be navigated by
voice, as you will see.

To close the active window, you can say click close, close window or press F4.

Resizing Windows and Switching Between Them

To minimize an active window, say click minimize or minimize window (the window remains on your screen,
minimized as a taskbar icon). To maximize (enlarge to fit the screen) an active window, say click maximize.
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If several windows are open on your computer, you can change which one is active and in the foreground in
several ways:

 Say “switch to” followed immediately by the name of the desired application, folder, or document:
e.g., switch to DragonPad, switch to Lotus Notes, switch to My Computer, switch to DragonBar,
switch to winter projects.

 Say switch to next window as many times as necessary to cycle through all the open windows (this is
equivalent to pressing Alt +Tab).

 Say switch to previous window to go back to the previously active window.

 Say list all windows then say (or press) the number of the desired window.

Note: particularly if many windows are open, you may wish to specify an application: say list windows
for <application>, for instance: list windows for Dragon or list windows for Internet Explorer.

“Clicking” menus, buttons and other interface controls

To "click" on an application menu or submenu, just say its name preceded by the word “click” (or not
depending on the option for menus—see below). For instance, for a menu labeled Insert, say Click Insert. (The
application must have the focus, which you can usually tell by the appearance of its title bar.)

When accessing a submenu, pause briefly after the name of the menu. For instance, in applications like Word
2003: to see the available toolbars, you can say click View (pause) click Toolbars, and to save a file under a
certain name, you can say click File (pause) Save As.
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TIP To close an open menu, you can just say cancel or press Escape (equivalent to pressing the Esc key at

the top left of your keyboard).

If you use Office 2007, familiarize yourself with the “Ribbon” and its ScreenTips (revealing the item’s name),

Quick Access Toolbar, and KeyTips (the new display of keyboard shortcuts). Note: to click the Office Button
(the equivalent to the File menu of earlier Office versions) by voice, say "click Office button".

Note: With Office 2010, Microsoft introduced some changes to the applications’ interface—in particular, it
introduced the File Tab. The other tabs can be accessed by voice by just saying their name, but for the File
Tab you must say “file tab” or “click file tab”. With Office 2013, Microsoft also made some interface
modifications. For details on support for Office 2010 and 2013, please see the resources on www.nuance.com
and the Help. (Remember that you can search Dragon’s Help directly by naming search keywords in a command
such as “search Dragon help for open quote office 2010 close quote.”)

.

TIP By default, some Microsoft applications show only the most used menu items. For optimal voice usage,

consider changing this default. (This may be located in the application’s Tools menu: open the Customize
dialog and check the box “Always show full menus.”)

In addition to menus, Windows program interfaces may contain controls such as buttons, checkboxes, tabs, and
radio buttons. How do you access these by voice? You guessed it: “say what you see” (preceded by “click” if
required).

IMPORTANT

 Dragon 12 lets you require the word “click” before the names of menus independently from buttons and
other interface controls.

 By default, Dragon 12 requires the word ‘click’ before the name of menus as well as buttons and other
controls: for instance, for a button labeled OK, you would say click OK. (This can be useful to prevent
unintended actions such as the voice-clicking of Send in email.) Dragon offers a similar “Require ‘Click’”
option for HTML links, which applies to hyperlinks in supported Web browsers as well as in the Tutorial,
Sidebar, and Accuracy Center. See the Commands tab of the Options dialog.
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This workbook presents several of Dragon’s dialog boxes, which often contain controls labeled Cancel, Yes, No,
or OK. As you follow the instructions and perform the exercises in each chapter, you may wish to take the
opportunity to practice accessing the controls by voice.

Exercise 1: Previous lessons introduced you to the Options dialog box; we will use this dialog box to
practice accessing buttons, tabs, and other interface controls.

1. Open Dragon’s Options dialog, then its View tab.

2. Select and unselect the radio buttons and checkboxes for the DragonBar.

3. Restore the defaults.

IMPORTANT Dragon 12 lets you disable its ability to “track” the name of interface controls, in all

programs or just in programs of your choice: see the checkbox and drop-down list “Voice-enable menus,
buttons and other controls” on the Miscellaneous tab of the Options dialog.
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“Natural Language Commands” and the Command Browser

Dragon comes with large sets of commands that let you order actions directly and in a natural manner, instead
of going through menus, submenus, and dialog boxes: for instance, saying “Insert Page Break” in Microsoft
Word 2003 instead of opening the “Insert” menu, then choosing the submenu “Break”, then the option “Page
Break”.

Dragon’s Sidebar contains a sampling of these commands when they are available (and if your edition supports
them). As you will notice, Dragon’s command names tend to describe the action, starting with the verb then
the object.

 To read about the commands for a specific application, open the Help (you can say give me help or
show Help topics) or launch a Help search directly with a command such as “search Dragon Help for
Internet Explorer commands.” You can also jump to relevant Help topics directly from the Sidebar’s
hyperlinks.
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 To see all the commands and their variations (optional words, alternate words, etc.), open the
Command Browser and use its Context list and Keyword Filter box to display just the commands that
contain a particular word or words and are active in a particular application. When you see in the list a
command that looks interesting, make sure it’s highlighted in the list then use the links on the
Command Browser’s menu to show all its wordings (for instance, to include all optional words or to
expand ellipses).

IMPORTANT If it detected that your PC’s resources would not allow it to perform with both speed and

accuracy, Dragon may have disabled its Natural Language Command sets for Word, Excel, PowerPoint and
WordPerfect. If speed is not a priority for you and you wish to use Natural Language Commands in one or all of
these applications, enable them via the Option dialog’s Commands tab. (See the More Commands button near
the bottom.)

Note that if you enable the Natural Language Commands for Microsoft Word, for instance, Dragon’s speed may
decrease within Microsoft Word (or Microsoft Outlook using Word as its editor).

“Voice-Pressing” Keys

At times, you may wish to use your voice to press a key or key combination on your keyboard.

TIP Common accelerator keys for Windows operating systems include: Esc to close a window, Enter to active

the item which has the focus, Tab to move the focus forward, and Shift Tab to move the focus backward. Most
buttons, menus and checkboxes have an underlined letter in their label: you can activate them by pressing the
underlined letter (if underlines are not visible, press Alt first.) For keyboard shortcuts specific to a particular
application, search the application’s Help or the Internet.

Dragon lets you “voice-type” keys on your keyboard. Just say press or type followed by the name of the key(s):
any letter or number, but also Page Up, Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift, Windows...

For instance:

Say press spacebar to select or unselect a checkbox.

Say press F5 or press Function 5 to refresh the view.

Say press Alt e to “click” a control labeled with an underlined ‘e’.

Say press Control f to open the Find field in most applications.

Say press Escape to “escape” out of a window.

Say press Alt Down to open a drop-down list.

Say press Windows D to show the desktop

Note: To undo a keystroke, you can say undo that.

Exercise 2: Observe the Find and Replace dialog box below and its controls: tabs, drop-down lists, checkboxes,
and buttons. Answer the following questions (think of “voice-typing” as well as “voice-clicking”
options), then open a similar dialog in your word processor and practice navigating it by voice.

 How could you place the insertion point in the Find field? How could you go to the other tabs?

 Which control currently has the focus? How could you move the focus to the Find Next button?
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 How could you close this dialog box?

Special considerations for Windows 8

In Windows 8, Microsoft introduced major changes for end-users compared to previous operating system
releases (some of these changes may feel strange at least initially), but Windows 8 does offer an interface
similar to the familiar desktop (minus its Start menu button). Applications such as Microsoft Word and Excel
open in that “classic” interface.

The Start screen and Charms bar

The Start menu of previous operating systems
doesn’t exist in Windows 8, but equivalent
functionality is provided by the Start screen and
the Charms bar (illustrated here).

In version 12.5 of Dragon, you can use the
commands “open Charms bar” and “open Start
screen.”

Remember that, if you know “accelerator keys” in the operating system or applications, you may wish to take
advantage of Dragon’s ability to press keys. For example, you can give the commands “press down arrow” or
“press Windows key” (this toggles to the desktop, or the Start screen, or the latest “modern” app open) or
“press Windows h” (this accesses Windows 8’s Share feature).
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TIP To see the expanded view of the Start screen, you can give commands including “show all applications.”

On the Start screen, if you type some keys, the Search field automatically opens up, displaying the characters
you typed; the same is true if you dictate. You can use this to search for or open items by voice. For instance,
if you wish to open the folder that contains the dragon log, you could say “dragon log” – and once the words
“dragon log” appear in the Search field, you can say “press enter” to activate the search result that is
currently in focus.

Desktop vs. “Modern”

Dragon is designed to be used primarily in the desktop environment, the “classic” interface.

Only there can Dragon’s various interface elements appear; this includes the Results display, the Sidebar, the
Vocabulary Editor, the Accuracy Center, the Open User Profiles dialog, the list of open windows, the Edit
Keywords window triggered by commands such as “search maps for…” If, while outside the desktop
environment, you do something that causes one of these windows to open, that window will be open on the
desktop.

Outside of the desktop environment, Dragon’s usual capabilities may not apply. In particular, there is no Full
Text Control.

Note: Dragon’s capabilities for Internet Explorer only apply to the desktop environment; they do not apply to
the Internet Explorer app (the full-screen “modern” app introduced with Windows 8).

The Audio Bar

As mentioned above, Dragon’s Results indicator (the “rolling” icon when dictation is recognized and the Results
box when a command is recognized) cannot appear outside of the desktop interface. In Dragon 12.0, outside of
the desktop interface, there is no indication of whether Dragon’s microphone is on, off, or asleep. In Dragon
12.5, if you wish to, you can open a small toolbar, the Dragon Audio Bar, which contains the microphone
button and volume meter. Note that the Audio Bar does not open by default. One can access it from the Start
screen.

IMPORTANT: By dragging the Dragon Audio Bar with your mouse, you can move it to a location that is
convenient for you. (Keep in mind that the Dragon Audio Bar is visible in the desktop environment, but there is
no need for it there.) If you wish to close the Dragon Audio Bar, click its “minimize” icon, the right-most icon
(this “minimizes” the bar in the sense of making it disappear; it does not close Dragon NaturallySpeaking
itself).

Below is a screenshot of the Dragon Audio Bar itself, as well as a screenshot of its “tile” on the expanded Start
screen.

Note: For the latest details on using Dragon in Windows 8, please see the Knowledgebase on the Nuance
website: http://www.nuance.com/support/dragon-naturallyspeaking/index.htm
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Key points about controlling your computer by voice

 At any time, no matter what is visible, you can open a Start menu or desktop item by saying start, launch,
show or open immediately followed by the name of the item. In version 12, these two powerful
capabilities can each be disabled or enabled from the Options dialog.

 You can switch between windows with commands like switch to WordPad and list windows for Dragon.

 To click menus, buttons, and other controls, you can “say what you see” (you can choose to say “click”
right before, or not).

 By default, Dragon 12 requires the word ‘click’ just before the name of menus as well as the name of
buttons and other controls: for instance, for a button labeled “OK”, you would say click OK. This can be
useful to prevent unintended actions such as voice-clicking Send in an email. Dragon offers a similar
“Require ‘Click’” option for HTML links. See the Commands tab of the Options dialog.

 You can “voice-press” one or more keys by saying press or type followed by the name of the key(s).

 Dragon offers “shortcut commands” to search your computer for items containing the keyword(s) you
specify. (These commands take advantage of indexing software which must be running on your computer).
For instance, to find all indexed e-mails containing the words “Canada” and “budget”, you could say
search email for Canada budget.

 If it detected that your PC’s resources would not allow it to perform with both speed and accuracy, Dragon
may have disabled its Natural Language Command sets for Word, Excel, PowerPoint and WordPerfect. If
speed is not a priority for you and you wish to use Natural Language Commands in one or all of these
applications, enable them via the Option dialog’s Commands tab. (See the More Commands button near the
bottom.)
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Using Dragon NaturallySpeaking with the Internet

What you can do on the Web with Dragon depends on what Web browser you are using. A key difference
between Internet Explorer and Mozilla Firefox is that Dragon doesn’t have Full Text Control in Firefox.

This lesson introduces commands for typical Web-related actions, including shortcut commands. The Command
Browser lists many more. Be sure to see the Help for details about using your voice on the Web and about Web-
related Dragon options.

The Web Shortcuts including “open top site for…”

Dragon includes commands you can say anytime to perform general Web searches, as well as searches in
specific categories (maps, news, products, images, videos) or specific websites, such as Wikipedia. You could
say for instance ‘search images for purple chrysanthemum.’ Dragon will then present, in your default Web
browser, the results your default search engine found for those words in its image category.

A key advantage of
these “Web search
shortcuts” is that they
can be used anytime,
no matter what
program is currently
active on your screen.
No need to first switch
to your browser. These
commands don’t even
require your Web
browser to be open!

TIP These commands

let you take advantage
of capabilities of
specific search
engines. For example:
conversions and
calculations, as in
‘search Google for 61
percent of 1400’ and
‘search Bing for 77
euros in dollars’.

These shortcut commands can be disabled or enabled on the Commands tab of Dragon’s Options dialog.

Controlled by the same option is a different type of Web shortcut command: open top [web] site… Instead of
presenting search results, this command directly opens the website corresponding to the top result of the
keywords you included in the command. Using such a command can be the quickest way to open the website
for an institution or Web-based application: for example, you could say “open top site for Facebook” or “open
top site for Nuance Communications.”

Before these shortcut commands are executed, Dragon gives you a chance to edit the search string: it opens a
small dialog box which lets you revise, replace, or augment your keywords. This lets you make your search
commands very precise, which means you will find more quickly what you wanted.
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This Edit box* is controlled by an option, enabled by default for Web and Desktop shortcut commands. Note: If
you turn this option off, you may not see any action right away after giving one of these commands; this is
normal since the search engine itself needs a moment to complete the requested action.

The Shortcut Commands for Social Media

Dragon offers commands to quickly post to Facebook or Twitter. In Version 12, you can disable these from the
Commands tab of the Options dialog, under the button “More commands.”

There are two ways to create your post:

 You can select some text you dictated or some text in an editable document, then say "Post that to
Facebook" or "Post that to Twitter."

 You can also append dictation directly in your command, as in the Web search shortcuts: say "Post to
Facebook" or "Post to Twitter" immediately followed by the text you want to post. For example, “post
to Twitter anyone know a great dentist in Burlington Vermont question mark.”

Dragon then brings up a dialog box where you can verify, complete or modify your text. Once you click OK,
Dragon will make the post for you.

Note: What Dragon executes with these commands is just making the post, as opposed to opening the Facebook
or Twitter websites. Showing you the post itself in its website if not part of the command’s execution. If you
wish to see your new post using just voice commands, you could for instance say “open top site for Facebook”
and then say “refresh page.”

Browser specifics

The following sections cover actions often performed in HTML pages. (There are many more commands; see the
Help and Command Browser.)

IMPORTANT: Whenever you use Dragon on the Web (whether for email or for something else), your

experience will depend on several factors, including:

 The particular settings in your browser and in the Web-based application,

 The design of the particular web page,

 What browser (and what version of that browser) you use. Be sure to see the Help for details including
browser specifics. What Dragon can do differs significantly among browsers. Examples:

o In Mozilla Firefox (outside of Gmail and Hotmail/Outlook.com), there is no Full Text Control, so you
may wish to use the Dictation Box (see the lesson Editing Text by Voice). Also, to click a hyperlink,
you may need to say its full (name preceded by the word “click”).
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o For Google Chrome, Dragon doesn’t have browser commands (such as “go to address bar”) or the
ability to click links by saying their name. In this browser, you can only use global commands (press
alt d, press enter, press Escape, press control t, press F5, page down, move mouse up, mouse
click, etc.) Also (outside of Gmail and Hotmail/Outlook.com), there is no Full Text Control in
Chrome: as you dictate in Chrome text fields, the checkmark icon on the DragonBar is grayed out.

o Dragon has many commands specific to Internet Explorer, including for text boxes or check boxes.

Here is an illustration of Sidebar content for Internet
Explorer, including commands specific to this Web browser.

Navigating to and within a Web page

Say go to address to go to the address bar; after entering a URL, say go there or press Enter.

Say go back or go forward to click the Back or Forward buttons; say go home to access the homepage.

Say add to favorites to add the current site to the Favorites list.

Say refresh page or reload page. (To stop a page load, you can say stop loading.)

Say page down or start scrolling down to see more of the web page. (You can then say stop scrolling.)

Say add a new tab, open new tab, switch to previous tab, close tab…

Say next frame, previous frame, next pane…

Say click close or press Escape to close a popup window.
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Accessing a specific item on a Web page

These commands require the setting "Enable commands in HTML windows," which is on by default and can be
found on the Commands tab of the Options dialog.

IMPORTANT: Dragon is always looking to match what it hears to possible commands. For HTML windows,

you can choose to require ‘click’, because saying a word or phrase in isolation may activate a link instead of
being transcribed—see the Commands tab of the Options dialog. This option is on by default.

For all these commands, if what you said matches multiple items on the screen, Dragon will display numbered
arrows next to the items; to indicate the desired item, say choose 3 or whatever number corresponds to your
choice. (If you need the numbers to go away, just say hide numbers.)

To click a hyperlink, say its name or just part of it, preceded by the word ‘click’ or not. (If a red
arrow appears next to it, say click that.)

The following commands apply only to Internet Explorer:
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Say click text field or edit box to move
the insertion point to the first text field
on the screen. If you want to dictate into
the next text field, you can say next
control.

Say click image to click on an image.
(Note: on the Web, some items may be
designed to look like text but are actually
images.)

Say click check box to select (or
unselect) a check box.

Say click radio button to select a radio
button (round option button).

Say click list box to select a list box,
then drop list or show choices to display
the list. (To highlight list items, you can
use the move up n and move down n
commands.)

Say click combo box (combination of a
drop-down list and a single-line textbox)

Key points about Dragon and the Web

 Dragon includes commands you can say anytime to perform general Web searches, as well as searches
in specific categories (maps, news, products, images, videos) or specific websites, such as Wikipedia.

 The shortcut command “open top site for…” can be the quickest way to open the website of an
institution or service.

 The Web shortcut commands can be disabled or enabled on the Commands tab of Dragon’s Options
dialog.

 Before executing these shortcut commands, Dragon opens a small box which lets you revise, replace, or
augment your keywords. If you wish to disable this Edit box, use the Commands tab of Dragon’s Options
dialog.

 Dragon offers commands to quickly post to Facebook or Twitter. In Version 12, you can disable these
from the Commands tab of the Options dialog, under the button “More commands.”

 Dragon is always looking to match what it hears to possible commands. For HTML links, by default,
Dragon requires you to say ‘click’, because by saying a word or phrase in isolation you could activate a
link inadvertently. (This requirement can be changed on the Commands tab of the Options dialog.)

 What Dragon can do differs significantly among Web browsers.

 In Firefox and Chrome, Dragon doesn’t have Full Text Control -- therefore you may wish to use the
Dictation Box. Exception: in Gmail and Hotmail/Outlook.com, if the Dragon plug-in is enabled, as
described in the section on Web-based email.
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Using Dragon NaturallySpeaking for E-mail

“Voice-typing” in itself is a great benefit for e-mail usage, but for certain e-mail applications, Dragon lets you
do much more. This lesson introduces important commands and tips for using Dragon with e-mail, including
shortcut commands and two popular Rich Internet Applications: Gmail and Hotmail/Outlook.com.

IMPORTANT Although Dragon can automatically format email addresses and URLs as you dictate them, it

can be efficient to add to the Vocabulary e-mail addresses and domains you use frequently (be sure to specify
Spoken Forms as needed). Users of Lotus Notes, Outlook, Outlook Express and Windows Mail should take
advantage of Dragon’s tool for adapting the Vocabulary based on sent emails as well as finding Contact names
to add. (See the Help menu’s Improve My Accuracy.)

Voice Shortcut Commands

Dragon has many commands for use in Microsoft Outlook, including in the Inbox (you can forward, move, or flag
messages, for instance) and in the Calendar.

For quickly creating messages, appointments, meetings, and tasks, Dragon offers “shortcut” commands that
work no matter what is currently active on your screen. At any time, you can say for instance create email to
Jane Miller and Payroll, schedule meeting with Joe Keller and Jane Brown, create appointment at noon,
schedule appointment on August fifteenth, create task about office supply inventory, or email the
selection to Jane Miller (“the selection” being the selected text or file).

Note: In version 12, for the shortcut for emailing the selection, “email the selection to…” is the only possible
wording. All previous wordings have been deprecated.

TIP Before using these commands, make sure Dragon is able to recognize unusual words such as the names

you plan to mention (use the Accuracy Center).

These shortcut commands can be
disabled or enabled from the checkbox
"Enable E-mail and Calendar commands"
on the Commands tab of the Dragon’s
Options dialog.
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To see more commands, you can explore the Command Browser’s “Context” list and take advantage of the
Sidebar as well as the Help: for instance, you could say “search Dragon help for Outlook calendar.”

Commands for your installed email program

You can start your default e-mail program by saying Start mail.

With the program’s inbox open, you can say:

new mail – creates a new mail message

open mail – opens the mail message highlighted in the list

close mail – closes the open mail message

forward mail / this– forwards the highlighted or open mail message

reply to mail / this – replies to the highlighted or open mail message

delete mail – deletes the highlighted or open mail message

check for new mail – checks for new mail/opens your Inbox

Note: In e-mail commands, you can substitute message, e-mail, or memo for the word mail.

TIP In lists (of messages, of folders…), you can use navigation commands like move down 3, move up 9, as

well as go to top and page down…
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When in a message, you can move between its fields by saying Tab or Tab key, or by saying the following
commands naming the desired field:

move to To [field]

move to CC | BCC [field]

move to Subject | Body [field]

Note: In these commands, the word “field” is optional, and you can substitute “go” for “move.”)

Dragon has hundreds of mail-related commands. To find wordings for an action that interests you in a
particular mail program, use the Command Browser: in its Browse mode, use the “Context” drop-down list to
pick the program, then use “Keyword Filter” to enter one or more words related to that action. The example
below illustrates a search for Outlook 2010 commands containing the word “sort.”

In Microsoft Outlook, you can also use your voice to move the selected email to a particular folder. For
example, if you have an Outlook folder called “ideas” and want to move the selected email to it, you could say
“move selection to ideas folder”. (You can use the Command Browser to see more wordings; in the “Context”
list, pick “Dragon – Shortcuts for MS Outlook.”)
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Web-based email and the Dragon plug-in

IMPORTANT: Whenever you use Dragon on the Web (whether for email or for something else), your

experience will depend on several factors, including:

 The design of the particular web page at that time

 The particular settings in your browser and in the Web-based application

 What browser (and what version of that browser) you use. Example: For Google Chrome, Dragon
doesn’t have Full Text Control. It also doesn’t have browser commands (such as “go to address bar”) or
the ability to click links by saying their name.

In three popular browsers, Dragon 12 has additional functionality just in Gmail and Hotmail/Outlook.com, as
described in the next section. At the time of its release, Dragon 12 has is no special functionality for other
Web-based email applications, such as Yahoo Mail.

This feature applies to Internet Explorer (version 9 or 10, 32-bit only), and the latest supported version of
Firefox and Chrome. Please see the KnowledgeBase at support.nuance.com for the latest details on supported
versions. (The makers of Firefox and Chrome frequently release new versions.)

Note: Internet Explorer 9 can be installed on Windows Vista and Windows 7, but not on XP.

IMPORTANT: For the feature to be active, you may need to close and re-open your browser once after

installing Dragon 12. Your browser may present a message (either full screen or just in a small part of your
screen) asking for authorization. Examples are illustrated below.
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NOTE for Internet Explorer: If you installed Internet Explorer after installing Dragon 12, you must install
Dragon files needed to use this feature in Internet Explorer. To do so, double-click the file setup.exe on your
original Dragon 12 installation medium (for most people, this is the installation DVD). A wizard window will
come up. On it, choose the Repair option, then click Next.

Full Text Control and the Dictation Box

In the web pages supported by the plug-in (Gmail and Hotmail/Outlook.com), you have Full Text Control even
in Firefox and Chrome: Dragon capitalizes the first word, adjusts spacing when you insert a word, lets you
give commands like “insert before launch meeting”...

In contrast, where the plug-in does not apply (i.e. any Web page outside of Gmail and Hotmail/Outlook.com),
there is no Full Text Control in Firefox and Chrome—therefore, in Dragon 12, the Dictation Box will open by
default when you speak (for instance, in the browser’s Address bar).

Notes:

 If the Dictation Box opens with text in it (as it would from the Address bar), you can take advantage of
commands like “delete line”.

 If you disable the Dictation Box option (see the Miscellaneous tab of Options dialog), you can work
around the text control limitations. Examples:

o Say “cap” before the first word (or, after the fact: “cap that”, or “capitalize <word>”)

o If you need to insert within existing text, say “spacebar” to add a space.

“Say What You See” and the graphic

A small graphic marks items that can be activated with the principle “click <name>” e.g. “click inbox” and
“click drafts”.

Navigate fields in any order

In a new email, commands like “go to body” and “go to subject” enable you to navigate the fields in any order
(as opposed to tabbing from one field to the next).
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TIP: Regardless of this feature and Dragon, it’s prudent to leave the To field blank until you’re ready to send!

(Also prudent is setting up some other protection, such as an automatic delay before the program actually
sends.)

See commands and information for the plug-in

There are several ways to find commands and other details for this feature.

 Say “show site commands”. At the bottom of
the resulting list is a link to details.

(The screenshot here is for Hotmail.)

 Read the Help. To launch a Help search
directly, you could say commands such as
“search Dragon help for Gmail.”

Note: if Internet Explorer or Firefox is the active window, the top of the Sidebar features a link to the main
Help article on the feature.

“Send” and differences among browsers

By design, the Dragon plug-in does not include a command for sending the email. This is meant to avoid
unintentionally sending an email before it is ready.
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The capabilities the plug-in provides add to what functionality Dragon already has for the particular browser.
Remember that Dragon’s existing capabilities differ significantly among browsers, both in terms of commands
and in terms of text control.

One is relevant to the Send button. In Firefox, you can activate buttons including the send button:
independently of the plug-in, you can say “click Send”.

Here are other differences among browsers:

 Dragon has commands specific to Internet Explorer, including commands for clicking text boxes, check
boxes, list boxes, and radio buttons.

 In Firefox and Chrome, there is no Full Text Control outside of pages specifically supported by the plug-
in.

 To voice-click a hyperlink in Firefox, you may need to say the link’s full name preceded by “click”.

 In Chrome, you cannot activate hyperlinks by name. Also, Dragon has no commands such as “go to
Address bar”, “open new tab”, “go home”, “refresh page”, etc. Of course you can take advantage of
global commands: mouse commands (such as “MouseGrid 3 9”, “mouse click”, and “move mouse upper
left”) and key-pressing commands (such as “press Alt d”, “press Enter”, “press control t”, “press tab”,
“press F5”, “press Escape” and “page down”).

Note: In addition to keyboard shortcuts of the Web browser itself, you may wish to take advantage of
keyboard shortcuts of Gmail or Hotmail/Outlook.com (as in “press control enter” for sending). Lists are
available on the Web, including on the websites of Google and Microsoft.

Key points about Dragon and e-mail

 In supported e-mail programs, the higher editions of Dragon provide many voice commands to perform
tasks related to creating and managing e-mails, such as open message, delete memo, go to Subject…

 In e-mail commands, you can use the words message, e-mail, memo, or mail interchangeably.

 If you have Microsoft Outlook and your edition of Dragon supports them, you can use direct commands
(the “Dragon Voice Shortcuts”) like book meeting with <contact(s)>, create message to <contact(s)>,
create email about <subject>, and create task about <subject>, at any time, no matter what
application has the focus (there is no need to first switch to Outlook). These shortcut command help
you quickly act on thoughts, with minimal interruption to your overall flow of activity.

 You can see more e-mail commands in the Command Browser and the Dragon Sidebar; in addition, the
Help contains many details about using Dragon with e-mail. Remember that Dragon contains a
command that lets you name keywords to search for in the Help: for instance, you could say “search
Dragon help for Outlook calendar.”

 Thanks to its plug-in for Internet Explorer (version 9 and 10, 32-bit only), Firefox, and Chrome, Dragon
12 has added functionality in Gmail and Hotmail/Outlook.com. This functionality comes in addition to
Dragon’s existing capabilities for the particular browser. A small graphic marks items that can be
activated with the principle “click <name>” e.g. “click inbox” and “click drafts”.

 For the Gmail and Hotmail/Outlook.com feature to be active, you may need to close and re-open your
browser once after installing Dragon 12. (Note: If you install Internet Explorer after Dragon 12, you may
need to re-launch Dragon’s installation.)

 When in your Gmail or Hotmail/Outlook.com account, you can say “show site commands” to see a list
of commands available thanks to the plug-in.
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Dragon NaturallySpeaking and Microsoft Word

In “Controlling the Operating System and Applications”, you learned about Natural Language Commands. Since
Microsoft Word is an application many people use, this chapter lists built-in commands for this word processor.
Corel WordPerfect has similar commands, so it shares the same Dragon Sidebar content.

Remember that if your system resources are low, enabling Natural Language Commands could decrease
Dragon’s speed. (Also, if an application’s set is disabled, the Dragon Sidebar will not show special content for
that application; instead, it will show Global commands).

In addition to commands, this chapter covers special points of interest regarding Microsoft Word: ctfmon.exe
and the Voice Notation feature.

TIP for Windows XP: turning off CTFMON

After installing Dragon on a Windows XP operating system, errors may start appearing if the Microsoft Alternate
User Input application (ctfmon.exe) is also running. You can disable ctfmon.exe easily thanks to a checkbox on
the Miscellaneous tab of the Administrative Settings dialog box.

Administrative Settings is in the DragonBar’s Tools menu. Note: before opening it, Dragon needs to close the
current profile, therefore a manual action is then needed.

“Voice Notations” in Microsoft Word documents

The higher editions of Dragon let you add “Voice Notations” in Word: text that can later be used with Word's
Accept/Reject Change functionality. A Notation could be anything you do not want permanently in your
document or you do not want transcribed, e.g. instructions you speak for the benefit of your assistant. Voice
Notations are not used by the Acoustic and Language Model Optimizer.

To add a Voice Notation, press the Esc key while dictating. Voice Notations are highlighted in green and
formatted as red italic text.

Commands specific to Microsoft Word

For applications like Word, Dragon has so many commands (and many different wordings for most commands),
that we couldn’t possibly list them all here or in the Sidebar.

If you are working in a supported application and you encounter an action you’d like to perform by voice, use
the Command Browser’s Context list to pick that application and use its Filter to see just the commands that
contain a particular word or words. If you see a command that looks interesting, make sure it’s highlighted in
the list, then use the Browse menu to uncover its full wordings (for instance, to include all optional words or
expand ellipses.)

TIP: If you say what you think is a command but Dragon takes no action or just transcribes the words on the

screen, look for the Results indicator (see the View tab of the Options dialog). If it does not show your
command (with a thick border around it), Dragon did not recognize what you said as a valid command for the
current situation: for instance, if you say "Insert a 2 by 2 table" when the insertion point is inside a table,
nothing happens because Word does not allow inserting a table inside a table.
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Pictured below is an example of a Help topic listing commands for working in Word documents.

Many of Dragon’s commands work for Word 2003, 2007, 2010 and 2013, such as:

 New file

 Save the file. Save file as.

 Create a 3 by 7 table

 Add page numbers [at bottom left| center | right]

 Delete next sentence

 Find a word. Find and replace.

 Set page orientation to Landscape

 Print pages 3 to 7. Print the selection. Print [this] page

 View page layout. Change view to print layout.

 Zoom to 50 percent. Zoom to full page. Change zoom to page width

 Set page width to 8 inches

 Show|Hide paragraph marks

 Double-space the document. Single-space this paragraph

 Set the font color to green in this line

 Set background to yellow

 Show word count
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Microsoft Word 2007 and the Office Ribbon

In addition to the Ribbon Interface (which organizes items by tabs instead of menus), Word 2007 introduced
new capabilities for which Dragon now offers Natural Language Commands, including the ones below.

Note: To click the Office Button (which replaces Word 2003’s File menu), you can say “click Office Button.”

Office Button menu

 Open/show document information [panel]
 Quick print [file/document]
 Save [document] as PDF
 Encrypt file
 Add digital signature
 Mark [the] file/document as final
 View/open/show [the] document management [task] pane

 Share [the/that/this] document/file

Common Tasks:
 Go to/Switch to/Hide/Open/Display thumbnails
 Turn side by side view off/on
 Add/create/insert [a] special character
 Add/create/insert [a] hyperlink/chart

Page Layout menu
 Create/add/insert a watermark
 Set the page color
 For themes :

o View themes; Set colors of theme
o Change the font of [that/the/this] theme

 For line numbering :
o Create/add line numbering continuously
o Delete/remove line numbering

Reference menu
 Previous footnote/endnote
 Create/add/insert [a] citation/caption
 Create/add/insert index
 Add [this/it/that] in the index

Review menu
 Show/view/open/hide/close [the] research pane
 Translate the first sentence/word. Translate the entire page
 For comments:

o Create/insert/add [a] new comment
o Erase/delete/clear all comments shown
o Go to next/previous comment

 Hide/close [the] review pane
 Accept/reject change and go to next

Blog Post menu

 Create a new blog account
 Open a blog post
 Publish [this/that] post to [the] blog account

Mailings menu
 Create blank/new envelope/label
 How/view/hide merge preview
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Microsoft Word 2010 and 2013

With Office 2010, Microsoft introduced some changes to the application interface – in particular, the File tab.
The other tabs can be accessed by voice by just saying their name, but for the File tab you must say “file tab”
(or “click file tab”.)

For details on support for Office 2010 and 2013, please see Dragon’s Help and website resources.

Note: For versions of WordPad that do not have a menu named “File”: you can say “click application menu”.
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Dictating and editing in Microsoft Excel

You can use Dragon to dictate and edit content into Microsoft Excel spreadsheets. Many Excel-specific
commands are built into the higher editions; the Dragon Sidebar window shows some, and the Command
Browser lets you discover the full set. In addition, the Help describes commands usable in Excel to fill or hide
rows or columns, sort, sum or average values, widen columns, and more (see Help example below.)

Remember that the Natural Language Commands for Excel may be disabled or enabled from the Options dialog.

In this lesson, sample steps guide you to practice tasks such as entering text, moving between cells, editing
existing cells, and correcting recognition errors inside cells.

IMPORTANT: If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3

through cell H3”), be sure to say the word “cell”. Note that, instead of the letters, you can say alpha, bravo,
Charlie, etc.

There are two editing modes in Excel: Quick and Full. Make sure you are familiar with how your version of
Excel functions, especially for editing content in cells; notice when the Status Bar (bottom left corner)
indicates “Edit” and when it indicates “Enter” -- as well as when the mouse pointer changes.

 Quick Edit: To enter new content into a cell, overwrite the current content of a cell, or format the
entire content of a cell. When you select a cell and begin dictating, a yellow background appears; if
the cell currently contains text, the dictated text will overwrite it.

 Full Edit: To edit the existing contents of a cell. Select the cell and say "Edit Cell" or "Press F2" to open
the cell for editing; the insertion point is automatically placed at the end of the cell. As you dictate,
the background changes to blue. Commands such as "New Line" operate within the cell.

TIP: To quickly enter a predictable series of values, such as days or months, you can use commands such as

“Monday through Friday across” or “July through December down.”
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Full Text Control in Quick Edits

You will want to practice entering data into a spreadsheet and navigate around the spreadsheet and within
cells, as well as dictate and correct text using commands like “correct <xyz>” (see Full Text Control, called
Select-and-Say in previous versions).

For the exercise below, the content of the spreadsheet is not important.

Step 1: Open Excel, say open document and locate
the relevant .xls file – or use a blank file.

Step 2: Say move to cell C7 (or Charlie seven.)

Step 3: Dictate your full name into the cell.

As you dictate, the cell background turns pale yellow,
indicating that Dragon is doing a Quick Edit.

Let’s practice correcting recognition errors so Dragon can learn from them:

Step 1: Say move to cell C 13 (or Charlie 13). Dictate some text that is likely to contain unknown words, such
as: “Travel to Ashtabula to provide support for Sporkatron, Inc.”

Step 2: Correct one of the recognition errors. (Leave the remaining errors as they are, so you can practice
coming back to this cell and correcting them later.)

Step 3: Say move down one to go to cell C14. Dictate some additional text that is likely to contain new words,
such as: “related to last week’s trip to Kenmawr—training Moosehart Insurance”

Now that you are out of the cell, practice going back to it and correcting the error(s) in it.

Step 1: Say move up one to move back to cell C13. Say a “correct <xyz>” command to correct another of the
errors Dragon made. Notice that the cell again turns yellow.

Continue correcting the text until it is accurate.

Step 2: Say apply. You are no longer in Quick Edit mode; the cell you were editing is still selected.

Now let’s practice entering numeric data rapidly into a row.

Step 1: Say move to cell B16 or move to cell Bravo 16 to move to the Breakfast row. Dictate a numeric value
such as six dollars and fifty cents.

Step 2: Say move right one to move to the next Breakfast entry. Fill in the rest of the row.
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Key points about editing cells in Excel

 You can navigate between cells using absolute commands such as move to cell A1 or relative
movement commands such as move up one, move right two, etc.

 If you want to mention a cell in a command (such as move to cell D5 or select cell B3 through cell
H3), be sure to say the word “cell”. You can speak the letters as alpha bravo Charlie, etc. instead of A
B C.

 If you wish to modify and add to the existing content of a cell, move to that cell, then say Edit Cell or
Press F2; the insertion point will appear at the end of the cell’s content and the cell will now have a
blue background. If you say commands like New Line and New Paragraph, these commands are
executed within the cell.

 If you just move to a cell and start to dictate, what you dictate will overwrite the existing content.

 You can use Dragon commands like select <xyz>, correct <xyz>, and insert before <xyz> to edit and
correct text in a cell.

 To complete entry and move down one cell, say press Enter. To cancel entry and remain in the cell,
say cancel or press Escape.

 Saying apply completes entry into a cell, and leaves the focus on that cell (exiting Quick Edit mode).
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Boosting Productivity with Custom Commands

In previous lessons, you learned various built-in voice commands to perform actions such as formatting text,
searching the Internet, creating a new e-mail, creating a new appointment… The higher editions of Dragon also
allow the creation of custom commands.

There are several types of custom commands; this workbook presents the “Text-and-Graphics” type, which
allows you to define boilerplate for Dragon to paste wherever you utter the command. As the name indicates,
this boilerplate can contain graphics, such as logos, scanned signatures, maps… Quick and easy to create, Text-
and-Graphics commands provide considerable time savings and convenience. In editions Professional and Legal,
you can even include fields in them—a very easy way to create templates that can be both created AND
navigated by voice.

Creating Boilerplate Commands (“Text-and-Graphics” Type)

Step 1: Open the MyCommands Editor—you can say add new command or choose Add New Command in
the Tools menu.

Step 2: Think of a name for your command and enter it in the MyCommand Name field.

IMPORTANT: The command's name is the phrase you will say to cause the command to execute. Choose it

well! It should be easy to remember and easy to say, like Paste Signature Block and Enter Home Directions.

 Choose a descriptive, meaningful name (as opposed to a name like “macro 3”.)

 Make it neither long nor short (between 2 and 5 words is usually best). Avoid single words, and
phrases you may need to dictate.

 Use words that are easily pronounced and recognized (all words in the command name should be in
the Vocabulary), and avoid symbols—for instance, use “number” instead of “#”, otherwise Dragon
would expect to hear “number sign” or “pound sign” when you say the command.

Step 3: In the Description field, enter some information about your command. This is optional, but it helps
remember any important details about the command (its intent, when and where you might use it…).

The following step applies only to the higher editions of Dragon.

Step 4: Optionally, choose a group. In the Group field, you can highlight and overwrite the default.

Creating custom commands groups can later
allow you to locate and manage many commands
quickly. Aim to name your groups meaningfully:
for instance, the name of the application or task
for which you are creating the command(s).

Once a command Group is defined, you can add
more commands to that group (Dragon will now
include it in the “Group” drop-down list).

IMPORTANT: If desired, you can always assign the command to another group later. Since the Sidebar’s

MyCommands tab only shows custom commands that are in the User-Defined group, you can choose which
commands to display there by making a “clone” of the desired command and assigning it to the User-Defined
group. (See this lesson’s section on cloning.)
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Step 5: In the Content field, enter what you want Dragon to paste when you say your command. (You may find
it helpful to enlarge or even maximize the Editor’s window so that a larger Content field is visible.)

TIP If the text you want already exists in electronic form, you can save time: highlight the desired

segment in the original document, then say “make that a command”. Dragon will automatically open
the Editor and paste the selection in the Content field. All you have to do now is specify the
command’s name and attributes, and edit the Content as needed.

As its name suggests, this type of custom command lets you include graphics as well as text: you can
paste images from another application into the Content field—many people include maps, logos, or
scanned signatures, for instance.

Optional: If desired, format the text entered in the Content field: you can use the buttons (bold, left-
align, center…) below it. Clicking the Aa button opens the Font window, where you can choose the
desired font style, size, color, etc.

IMPORTANT: In cases where you want the content to match the formatting of what preceded it in

your document, check the Plain Text checkbox (see the bottom right of the MyCommands Editor).
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Step 6: Once the command is named, edited, described, grouped, and formatted as you want it, click Save.

Let’s test your command. Say start DragonPad, then say your command’s name. (Commands you create
yourself follow the usual rule: you must pause before and after, but not in the middle!)

You may realize now that you could make your command even more convenient: for instance, by adding a
blank line before the content so your pasted content automatically starts as a new paragraph. A section below
explains how to edit a custom command.

“Cloning” Commands and Adding Name Editor Variables

Instead of making a command from scratch, you can create a new command based on the “clone” of an
existing one, by clicking New Copy on the Command Browser (or the Create New button on the Command
Editor.)

In addition, the MyCommands Editor’s Name Editor allows the inclusion of <variables> in your command
names. Variable names provide flexibility (so you can use synonyms instead of just one wording) and can make
your custom commands even more useful, by letting them perform variations on the same action.

The variables can be synonyms, or they
can be different values, such as numbers
from 1 to 10.

<1to10> is one of the pre-filled lists
available through the Name Editor, but
you can also make your own (as was done
for <hq_nuance> in this lesson’s
illustrations).

See the Help for details.

“DragonTemplates”: Boilerplate Commands with [Fields]

(Higher editions only) Dragon 10 added to the Text-and-Graphics command type a new capability which gives a
very simple way to paste a “voice template” containing fillable fields.

To create a field in a command’s Content box, click the Variable button at the bottom of the MyCommands
Editor. By default, each field appears between square brackets as "[default value]". (If you prefer delimiters
other than square brackets, you can indicate that in the Commands tab of the Options dialog.)
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After saying the command name, which pastes the “DragonTemplate”, you can:

 type or dictate a specific value in each placeholder —> The placeholder is overwritten, and delimiters
are removed.

 accept the default value —> Delimiters are NOT automatically removed; you can say "clear variable
delimiters".

To navigate a DragonTemplate’s Fields, you can select the desired Field with the mouse, or use the voice
commands "Next Field" or "Previous Field." (These commands only work where all of Dragon's functionality is
supported—where the DragonBar’s Full Text Control indicator is green).

Managing Custom Commands

After you create commands, you may wish to edit them. If your phone number changes, for instance, you may
want to edit commands containing it. You may also want to rename, delete, or copy commands.

A tool called the Command Browser lets you search for commands as well as manage your custom commands.
In the Professional and Legal editions, deleting, renaming, modifying, exporting and importing custom
commands can be done through its Manage “mode”, as follows. (In the Premium edition, see the Script
“mode”.)

Step 1: Say open Command Browser. (You can also use the link in the Tools menu.)

Step 2: On the Mode section of its Task
Pane, click Manage (or choose
it from the Mode menu.)

Step 3: Open the Group drop-down
list. If you created a separate
group as suggested earlier, its
name will appear here; choose
it. Otherwise, the commands
you made will be under User-
defined.

Step 4: The Command Browser now
displays only the commands in
the specified group, listing
them by availability. You can
use the + symbol to expand the
display.

Step 5: Check the box next to the
desired command, then click
To Script (which at that point
will be available in the Task
pane.)

This takes you to the Command Browser’s Script display, which shows all the modifiable commands.
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Step 6: With your command
highlighted, click Edit in
the Task pane (or use the
Script menu). The
MyCommands Editor will
open, displaying the
command’s attributes and
content; you can now edit
the command as desired.

Remember: the Description field is
useful for entering comments such
as where and when the command
should be used, or reminders like
“make variations of this ASAP” or
“change this after we move”. Your
notes may seem obvious at the
time, but they really help later!

IMPORTANT You can delete

commands visible through the
Script or Manage displays: check
the box next to the desired
command(s) then choose Delete
(from the menu).

Finding commands via the Command Browser’s Keyword Filter

One of the ways you can find commands in the Command Browser is by using the ability to filter the display to
show only the commands whose name contains a particular word or words: choose Filter from the Command
Browser’s toolbar (visible in the upper-right corner when in Browse Mode) to specify one or more words. The
Filter button is useful for finding custom commands (particularly if they were not filed under a Group name),
and also for finding built-in commands, since Dragon contains far too many to list even in the online Help.

TIP It’s a good idea to explore the Command Browser for commands related to items you might like to

address by voice: you might filter for words like border, indent, double space, table, row, column…

The Command Browser’s display may seem strange at first, because instead of full words some lines may
contain ellipses (dot dot dot), parentheses, and <angle brackets>, in order to fit in the space and represent the
many optional and alternate elements, like “the” and “a”. You can view the full wordings by using the Browse
menu’s items—Refine and Undo All are particularly useful.

To practice, pick your usual word processor in the Context drop-down list, and use the Filter to find commands
on items you often use in this application.
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Key points about custom commands

 In the higher editions, you can quickly create custom commands to insert blocks of text and/or
graphics in your documents. This is done in the tool MyCommands Editor, which you can bring up by
saying add new command.

 If the boilerplate text already exists in an electronic document, you can copy and paste it into the
MyCommands Editor’s Content box, or say make that a shortcut.

 It’s a very good idea to use the Description field to note a comment, a reminder…

 Names for custom commands should be memorable, intuitive, easy-to-pronounce phrases. Avoid names
that could be used as dictation, such as single words.

 The Name Editor lets you add <variables> in command names, to provide synonyms or variations (using
lists you define yourself, or existing lists such as <1to10>).

 In the Professional and Legal editions, you can add fillable [Fields] to your boilerplate commands to
create “DragonTemplates” which can be navigated and filled out by voice.

 In the Professional and Legal editions, the Command Browser allows you to rename, modify, “clone”,
delete, export and import custom commands.
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Performing Audio Checks and Acoustic Training

As described earlier, personalizing Dragon’s vocabulary is a small investment of time that makes a big
difference in how accurately the software can work for you. In addition, when misrecognitions do happen,
using proper correction technique allows Dragon to learn from its mistakes.

In certain cases, you may also want to perform additional acoustic training to improve accuracy. This lesson
presents how to train individual words or phrases and how to bring up a training text to read aloud, as well as
how to use the Microphone Check, a short but important process.

IMPORTANT: When providing Dragon with acoustic training, be sure to use your natural dictation voice:

relax, and speak clearly but not louder or slower than you would when dictating normally. Otherwise, you give
the software acoustic data that is not representative of how you usually dictate. Remember, when you are
training software to accurately recognize your speech, you must represent your speech accurately!

The Microphone Check

Use Dragon’s audio check if something in your environment has changed: new computer, new microphone, new
room, different ambient noise… Also, if your overall accuracy is lower than expected, you want to verify that
your audio hardware is functioning correctly.

NOTE: Opening this Wizard automatically turns off the microphone.

Step 1: From the DragonBar’s Audio menu, click or say Check Microphone, which opens the microphone check
wizard (formerly called the Audio Setup Wizard). You can also bring it up directly by saying check
microphone or check audio.

Step 2: Follow the Wizard’s screens as when you first created your Dragon profile: click the Start button and
read the content of the gray box. Dragon will indicate whether the check passed.

 If it failed, verify that your microphone is plugged in correctly and that its listening side is facing your
mouth. (On many microphone models, the listening side is marked by a dot or the word TALK, which
may be under the foam cover.) If your microphone is properly connected and positioned, there may be
a problem with background noise (including “subtle” noises such as your building’s temperature-control
system) or with your audio hardware. Click the Help button and see the Knowledgebase of Technotes if
needed.

 If it passed, click Finish. (If, once you resume dictating, accuracy is still lower than expected, see
Improve my accuracy from the DragonBar’s Help menu.)

Training Individual Words and Phrases

You have learned to add new words and phrases to the vocabulary, as well as to create Spoken Forms for
items pronounced differently from the way they are written. Spoken Forms are often the most efficient way to
ensure accurate recognition.

If you suspect that Dragon needs help recognizing a tricky word (particularly if it contains one or more sounds
you cannot represent in a Spoken Form, such as a rolled r), you can acoustically “train” that word.



Copyright  2013 Nuance Communications, Inc. All rights reserved 112

Step 1: In the Vocabulary Editor, locate the word you wish to train by entering it in the Written Form field. (If
you have just added the word, this will not be necessary, as the word will already be displayed at the
top of the list.)

Step 2: Click the word in the list so it is highlighted, then say or click Train. The Train Words window opens.
Are you ready? (If you need to clear you throat, do it first!) Click Go, and read the prompt in your
normal speaking voice, as if you were saying this word in the middle of a sentence.

Step 3: You may have to wait a second for this
acoustic information to be incorporated -- be
patient! Then you can say or click Done to
close the Train Words window.

Reading Text to Train Dragon

Consider providing some reading for acoustic training after the first few days of practicing dictation: by then,
speaking clearly into the microphone should be familiar, and reading aloud text presented by Dragon should
better reflect how one actually dictates. If your speech presents a particular challenge for speech recognition
(due to a lisp or a strong accent for instance), you should perform a reading for acoustic training as soon as
possible.

Step 1: From the DragonBar’s Audio menu, click or say Read a text to improve accuracy. (You can also use the
link in the Accuracy Center.)

Step 2: When the Select Text window opens, choose a text to read, then click OK. The General Training
window will open. Click Go to begin reading.

IMPORTANT: Try to speak clearly but naturally and read exactly what is on the screen. If the software

needs to hear you read something again, a yellow arrow will show you where to resume reading. If necessary,
click Pause, then click Go when you are ready to resume.
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Key points about acoustic training

 In general, the best thing you can do to make Dragon recognize your speech even better is to use the
software regularly, personalizing the Vocabulary (editing Spoken Forms or Word Properties as
warranted, designating specific documents for Dragon to analyze, running or scheduling the Accuracy
Tuning process…) and correcting misrecognitions as warranted.

 In certain cases (if a certain word is consistently misrecognized, or if overall accuracy is lower than you
expected), you will want to provide Dragon some additional acoustic data.

 You can train Vocabulary entries from the Vocabulary Editor (either one at time or several at once).

 When providing acoustic training, remember to speak as you typically do when you dictate to Dragon.
It’s important to avoid the temptation to over-enunciate or speak loudly when training a word or
phrase in isolation.

 At any time, if you feel that the accuracy is not as high as usual, you can access Dragon’s Microphone
Check—through DragonBar’s Audio menu or the Accuracy Center, or by saying a command such as
Check Audio.

 You can improve the overall accuracy of your dictations by reading aloud one of Dragon’s acoustic
training texts (you can go through the DragonBar’s Audio menu or the Accuracy Center). Consider
reading at least one training text as soon as possible.
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Using Multiple Vocabularies (editions Professional and up)

Every Dragon NaturallySpeaking user automatically has at least one Vocabulary. Editions Professional and
above, allow you to have several Vocabularies. The advantage of having several Vocabularies is being able to
customize each one to perform best for very different topics or styles of dictation. (It is relatively rare for a
person to need more than three or four.)

For instance, suppose an architect uses Dragon to dictate business letters and site reports, but also frequently
uses it for his community theater group. In his work-related dictations, he might use formal business language
and mention technical terms, brands of materials, the abbreviations for building codes, as well as the names of
clients, contractors and other work contacts. When writing for his theater group, however, his dictation style
might become significantly more casual and the words he uses most frequently would be different.

The documentation contains many details about creating and managing vocabularies. This lesson presents the
essentials.

Creating a New Vocabulary

The process starts in the Manage Vocabularies dialog
box.

Step 1: Say Manage Vocabularies or use the
DragonBar’s Vocabulary menu. Click New.
(Note: this dialog box also enables you to
manage vocabularies: import, rename,
delete… See the next section.)

Step 2: In the New Vocabulary window, enter a
descriptive name in the Name field. From the
drop-down list, choose the vocabulary on
which you want to base your new vocabulary
(what you see in the list varies if you have the
Legal edition):

 If you want your new vocabulary to contain the customizations already present in your existing
vocabulary, choose this existing vocabulary: e.g. General – Large.

 Otherwise, choose the Base vocabulary.
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Step 3: Dragon will then offer to perform a basic adaptation of this new vocabulary based on documents found
on your computer, or sent emails (this is similar to what Dragon offers when you create a profile).. This
automatic process may take a while, and is not as powerful and targeted as the other vocabulary tools.
You can choose Cancel, then customize your new vocabulary using what you learned in previous
lessons. Remember that designating documents for Dragon to analyze is particularly important for good
accuracy, in addition to adding written forms and spoken forms to the vocabulary… (see the Accuracy
Center).

Managing Multiple Vocabularies

After creating (or importing) a new Vocabulary, you may wish to rename or delete it; both are done in the
Manage Vocabularies dialog box, accessible from the DragonBar’s Vocabulary menu.

From there, you can also Export a Vocabulary, to burn it to a disk or save it to a USB drive, for instance.

This would allow you to share it with other users of Dragon: the recipient user just needs to open the Manage
Vocabularies dialog, choose Import and browse for the exported Vocabulary’s .top file. (See the Help for more
details.)
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Opening a Particular Vocabulary (and Audio Source)

During your dictation session, you will be able to switch to a different Vocabulary, by saying open recent
vocabulary, for instance.

If you have multiple Vocabularies for the same User profile, this will be reflected in the Open User Profile
window, which will appear when you start Dragon.

The Open User Profile window
also shows the different dictation
source(s) that may be available
for the User profile(s) present on
your computer.

You can pick the line containing
the Vocabulary (as well as User
Profile and Source, if applicable)
you wish to open.
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Key points about multiple Vocabularies

 If you dictate on two or more very different topics, using different customized Vocabularies will
maximize your recognition accuracy (in supported editions). Each Vocabulary can be customized using
the tools in the Accuracy Center—adapting to documents you designate, for instance.

 If you have several Vocabularies, you will be prompted to choose one when you start Dragon. You can
switch to a different Vocabulary later, by saying open recent Vocabulary, for instance.

 The Manage Vocabularies dialog lets you create, delete, open, rename, import and export
Vocabularies; it opens with the command manage Vocabularies (or from the Vocabulary menu).
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Acoustic and Language Model Optimization

Vocabulary customization and proper correction of recognition errors both help Dragon recognize your
dictations more accurately. “Accuracy Tuning” is a functionality you can use to further “tune” your profile’s
accuracy for your specific usage. It has two aspects:

 It can refine your User profile using the latest acoustic data archived from any corrections and acoustic
training you performed.

 It can use text from your previous dictations to add frequent word sequences to the Language Model
-- statistics Dragon uses to “predict” which words and spellings it should write when you dictate.

IMPORTANT: If you have recently dictated in a very different sound environment, such as an airplane, you

should not let Dragon perform Acoustic Optimization.

In Dragon12, when your profile is saved (for instance, when you close Dragon or your profile), Dragon may offer
to optimize the Language Model based on the text data of your recent dictations. The Save User Profile dialog
box will contain a checkbox for performing “maintenance.” Note: This process takes little time. Language
Model Optimization is much quicker than Acoustic Optimization because the data it processes is just text.

The Accuracy Tuning process becomes available once you have used Dragon for a while (the software builds up
an archive when you perform dictations, corrections and training). A message box will let you know once
Dragon has enough for its automatic optimization.*

How much of an accuracy boost you will get from Accuracy Tuning will depend on factors such as the amount
and quality of the initial training and optimization (if performed during profile creation), the initial accuracy
you experienced, and the amount and quality of text and audio data available for processing.

You can choose to schedule the two components, Acoustic Optimization and Language Model Optimization, to
run periodically at a time and frequency of your choice. You can also launch one or both yourself, as shown
below.

Launching the Acoustic and/or Language Model Optimization

Step 1: Use the DragonBar’s Audio menu (or the Accuracy Center’s link “Launch Accuracy Tuning now”).
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Step 2: Check the checkbox for Acoustic Optimization and/or Language Model Optimization as desired, then
click Go.

Note: Language Model optimization is typically much faster than Acoustic Optimization.

Scheduling the Optimizations and Data Collection

For convenience, Dragon lets you schedule a specific time and frequency for these optimizations. You can do
this at the time you create your profile, and you can also do it later by going to the Administrative Settings
dialog (available from the DragonBar’s Tools menu) and using its Scheduled Tasks tab.

IMPORTANT: When you schedule a Dragon task, pick a time when your computer will be on (not

sleeping, not hibernating), but Dragon will not be running (not even in its QuickStart mode).

The documentation contains details about how end-users and Administrators can access these optimizations
and Dragon’s scheduling (the latest documentation is available on the Nuance website).
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In addition to Accuracy Tuning, Dragon allows you to enable and schedule another periodic task: the automatic
sending of anonymous data on your usage of Dragon (such as which optional settings you have, which
commands you use often, how often you make corrections, which language you use, which processor is on your
computer, what version and edition of Dragon you have), over the Internet. This Data Collection option helps
Nuance’s Research & Development team learn what customers around the world need, in order to improve
future releases of Dragon. You can choose to disable or enable it at any time.
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The Data tab of the Options dialog.

Note that it includes the setting for
the frequency at which Dragon
makes a backup of your profile (by
default, Dragon does it every five
times your profile is saved).

Key points about Optimization

 Acoustic and Language Model Optimization can automatically “tune” your profile by “reviewing” the
acoustic data and/or text data it has gathered from your usage of Dragon so far.

 Optimization can be launched at any time from the DragonBar’s Audio menu or the Accuracy Center. It
can also be scheduled, so that Dragon performs it at a specific frequency and time. Language Model
optimization is typically very fast. You can schedule it to run daily.

 When scheduling Accuracy Tuning or and Data Collection, pick a time when your computer will be on,
but Dragon will not be running (this includes running in its QuickStart mode).
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Renaming, Deleting, Copying or Transferring a User Profile

As you learned, each person who uses Dragon NaturallySpeaking creates a User profile, which the software
holds in a set of files that contains, among other things, acoustic and lexical data. When you add a
personalization to the Vocabulary (spoken form, alternate written form, capitalization property…), correct a
recognition error, read a training text, or change an option, Dragon can save these changes in the open profile.

Although Dragon automatically creates a profile backup (by default, every five times the profile is saved), it is
a good idea to keep your own record of customizations, by exporting your custom words for instance, or noting
what Word Properties you have changed.

You can also copy your whole profile, for safe-keeping or to make it available on another computer. In editions
Premium and above, transferring a profile is a simple two-part process accomplished through the Manage User
Profiles dialog box.

Step 1: Say manage user profiles (or choose Manage User Profiles in the DragonBar’s Profile menu). In the
Manage User Profiles dialog, select your profile, then choose Advanced then Export. (You may see a
message about saving changes to the current profile.)

Step 2: A Browse dialog opens. Choose a destination (if you wish, make a new folder) then click OK.

If both computers are on a network with a shared drive, this drive is probably the easiest location.
Otherwise, you can export your profile to a media storage device, such as a portable USB drive.

Now that your User profile is exported, it can be imported:

Step 1: From the second computer, open the Manage User Profiles
dialog. Choose Advanced> then choose Import.

Step 2: When the Browse window opens, locate the folder containing
the exported profile (this folder bears your profile’s name).
Once it is highlighted, click OK.
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The Manage User Profile
dialog box also enables you
to rename or delete a
profile.

Its Properties button also
allows you to see a profile’s
Properties (such as its
source(s), backup location,
and date of last backup).
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Key points about exporting and copying a user profile

 In editions Premium and above, exporting and importing profiles is done through the Manage User
Profiles dialog box—available through the DragonBar’s Profile menu or by saying manage user profiles.

 You must export the profile from the original computer, then import it to the recipient computer.

The documentation contains more information about managing User profiles: deleting, renaming, backing up,
restoring… See for instance topics on Dragon’s Roaming User feature (available in Professional and higher
editions), which presents administrative advantages and is particularly useful for people who frequently dictate
from different PCs connected to the same network.
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Practice Exercise: Creating a Memo by Voice

Open DragonPad or another supported word processor. Using your new dictation and formatting skills, try to
create the following document entirely by voice. After you have created the sample signature block shown in
the sample below, replace it with your own signature information.

Take this opportunity to practice looking up keywords in the Help to find out more ways to accomplish a
particular task. Remember that you can use the Sidebar and the command “search Dragon Help for…” and
that Dragon has a “quote that” command!

August 5, 2012

AnyCorporation

Gene Hansen-Wolffe

P.O. Box 3299

Minneapolis, MN 67812-3299

Dear Gene,

I am pleased to report that “my” team has reviewed the Western Region Report for this quarter.
As of July 29, 2012:

the total is $875,500 [as we expected].

Please let me know your projected figures for the rest of Q3.

As always, don’t hesitate to contact me at the number below.

Sincerely,

Sara Petersen

Regional Sales Manager

My Company, Inc.

202-965-5000

mobile: 715-377-1925

fax: 800-968-2231

sara.petersen@mycompany.com
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What’s New in Version 12.0?
Here is a list of changes and additions compared to Dragon 11.5. If you are upgrading from a previous release,
please see also What's New in Dragon 11 and What's new in Dragon 11.5.

Options to require "Click":

Now saying "Click" is required for everything, by default

By default, as it does for hyperlinks, Dragon now requires you to say "Click <menu name >" or "Click <tab
name>" to open menus or tabs on the Microsoft Office ribbon, or "Click <button name or list box name>" to
select dialog box controls. For example, to open the Home tab on the ribbon, you would say "Click Home"
rather than just "Home."

Now you can require "Click" for menus or controls separately

Also, the former combined Require "Click" option has been divided to give you finer control. Now you can
require click for menus independently of buttons and other controls.

For example, you could set up Dragon to require that you say "Click" before menu names but not inside dialog
boxes.

The Dictation Box can open automatically:

When you start to dictate in an unknown text field (a text area where Dragon doesn’t have Full Text Control,
such as in Microsoft PowerPoint, or Mozilla Firefox and Google Chrome in pages where the Dragon plug-in
does not apply), Dragon now automatically opens the Dictation Box, to provide you Full Text Control. Once
your text is ready, you use the box’s Transfer button, and Dragon closes the box and inserts your content into
the text field where you started.

The option to automatically open the Dictation Box can be turned on and off in the Options dialog box,
Miscellaneous tab.

Note: By default, to voice-click the Transfer button, you must say “click transfer” and not just “transfer”
(given that the option “Require ‘click’” is enabled).

If this new option is disabled, you can open the Dictation Box when you wish, by using its hotkey or its entry in
the Tools menu, or by voice commands such as "show Dictation Box," as in previous versions.

Smart Format Rules:

When you make a correction related to formatting, such as abbreviations, titles, units of measure, or
alternate written forms, Dragon displays its Smart Format Rules box, offering to change one of its Auto-
Formatting options or Word Property settings. You can then either accept one of the adjustments offered, or
dismiss the box.

If you wish to, you can change settings yourself from the Auto-Formatting Options dialog box or the
Vocabulary Editor, as in previous versions. The Smart Format Rules feature simply "reaches out" to you,
making it quick and easy for you to adjust the settings you care about.
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Rich Internet Application support: enhanced experience for Gmail and Hotmail

In addition to its existing functionality for Web browsers, Dragon 12 includes browser extensions—also known
as plug-ins or add-ons—for two popular Web-based applications: Gmail and Hotmail. In these two Rich
Internet Applications, the Dragon extensions give you Full Text Control in text fields and enable spoken
commands for important tasks (excluding sending).

In Dragon 12.0, this feature is supported for the following browsers: Microsoft Internet Explorer 9 (32-bit),
Mozilla Firefox 12 or higher, and Google Chrome 16 or higher.

In the specific websites it supports, this new feature adds to the existing capabilities in the particular Web
browser. Remember that Dragon functionality differs significantly among browsers. For example:

 In Firefox, you can voice-click buttons by saying, for instance, “click Send.”

 In Chrome, you cannot select hyperlinks by name, and also there are no commands such as “refresh
page” and “open new tab”. For these actions, you can take advantage of global commands: mouse-
related commands (such as “MouseGrid 3 9”, “mouse click”, and “move mouse upper left”) and key-
pressing commands such as “press alt a” (to go to the Address bar), “press F5” (to refresh), “press
control t” (to open a new tab) and “tab five times”.

Note: You may want to familiarize yourself with the keyboard shortcuts of Gmail and Hotmail – as well as the
keyboard shortcuts of Google Chrome, if that’s your preferred browser.

Shortcut command “Open Top Site for…”:

The shortcut command "Open Top [Web] site…" directly opens the top-ranked page for the keywords you
include when you dictate the command. You can say this command at any time, whether or not a Web
browser is currently open. This is a convenient way to quickly open the website of a company or institution.

Enhanced Performance Assistant:

The Performance Assistant, a Help tool you can use to find ways to boost Dragon's speed, is now linked from
the Accuracy Center and includes suggestions for turning off functionality you may not need or want, such as
the following:
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Disable command functionality:

Dragon has many powerful command capabilities which you can choose to turn off if and when you don’t
need them. (This can be particularly helpful for beginners or anyone who sometimes wishes to focus on
producing text.) Turning off these options can help avoid unintended actions, such as clicking a button in
your email program.

 To turn off the ability to open Start menu and Desktop items even when they are not visible: go to
Tools > Options > Commands.

 To turn off the ability to “voice-click” interface controls in one or more programs: go to Tools >
Options > Miscellaneous and see the checkbox and drop-down list “Voice-enable menus, buttons and
other controls, excluding:”.

Option for multiple text matches:
Dragon's multiple text matching feature enables you to apply changes to multiple instances of matching text in
your documents. Dragon now includes an option to turn the feature off as required.

Text-analysis reminders: have Dragon analyze sent emails and specific documents

Dragon can now help you remember to take advantage of an efficient way to make your profile more accurate:
a new reminder window prompts you to have Dragon adapt your profile’s vocabulary based documents of your
choice and on your sent e-mail messages. This analysis is very important, in addition to adding phrases and
spoken forms to the vocabulary.

Also, the two features you'll be using to make these improvements – the former Increase Accuracy From E-Mail
and Add Words From Documents tools – are renamed "Learn From Sent E-mails" and "Learn From Specific
Documents."

Optimizing the Language model: a quick way to refine your profile from your previous dictations
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When you save your user profile, Dragon may offer to optimize the Language Model based on the text data of
your recent dictations. The Save User Profile dialog box will contain a checkbox for performing “maintenance.”
This process takes little time.

Note: Language Model Optimization is much quicker than Acoustic Optimization because the data it processes is
just text.

State-of-the-art speech model for powerful PCs:
If yours is a powerful PC with two or more processors, Dragon automatically selects the BestMatch V, its latest
and greatest speech model, when you create your user profile.

The Interactive Tutorial:
Dragon now features an interactive tutorial, which provides short, progressive simulations so that you can
practice dictation, correction, spelling, and editing efficiently. Content includes the “press” and “go back”
commands as well as the Smart Format Rules feature. The interactive tutorial is automatically presented at
the end of profile creation. You can also access it at any time from the DragonBar’s Help menu. (To do this
by voice, say "Switch to DragonBar," then "Help," then "Interactive Tutorial.")

Note: To provide an optimal environment for beginners, some of Dragon’s usual capabilities are disabled in
the interactive tutorial. For instance, you can only speak the current prompt, and you cannot use your voice
to click anything.

Richer Help menu:

The DragonBar’s Help menu provides access to many Help tools, including the Accuracy Center, the
Performance Assistant, Dragon's Help, the Tip of the Day, the Sidebar, the regular Tutorial and the
Interactive Tutorial. You'll also find Web links for software updates, the main Dragon page on the Web,
Technical Support pages, and product registration.

The Help menu also includes a link for printable User Documentation on the Nuance website.

Note: At any time, you can access the Help at any time by saying "Give me help."

Also, at any time, you can also say "Search the help for <xyz>" to directly open the Help window and launch a
search for a word or phrase of your choice. For example: “Search Dragon Help for open quote dictation box
close quote”.

Sidebar font size:

Now you can change the size of text in Dragon's Sidebar – make the text smaller if you want to make the
Sidebar thinner and prevent the text for the commands from wrapping, or you can make the text larger to
reduce eye strain.
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Tip of the Day:

The Tip of the Day (which displays by default when you open a Dragon profile and is available from the Help
menu) contains many new tips. Also, its redesigned window adds a Back button so that you can browse through
the tips in either direction. Note that until you use the Next button, Dragon will present the same tip each
time the window opens.

DragonBar minimized in the System Tray:

If you like to keep the DragonBar minimized as a Tray Icon only, now you can display its content by voice
command as well by right-clicking the icon. Just say "Open Dragon’s tray menu.”

“List all windows” and “List windows for Dragon”:

Dragon's command to open a numbered list of open windows now includes Dragon windows (Dictation Box,
Vocabulary Editor, Command Browser, and others). And if you want to see just the Dragon windows, you can
say "List windows for Dragon," like you can say "List windows for Internet Explorer."

Faster restoring of user profiles:
If Dragon was unable to open your profile, it presents the Launch Restore window, where you can choose from
available backups.

Note: Dragon offers many ways to refine your profile. The more refined your profile, the more you can reap
Dragon’s time-savings and convenience benefits. Your profile is important. As for all important data, it’s a good
idea to make a backup of your profile regularly and copy it to a location outside of your usual computer

New Text-To-Speech voice:

Dragon now provides more natural Text-To-Speech voices. (To try it, you can select some text in an editable
document and say "Read That.")

Wireless dictation with smartphones and related devices:
The Dragon Remote Microphone app released with Dragon 11.5 for iPhone and other iOS devices is now
available for Android. Once the app is installed on the Android device, you can set up your device with Dragon
and use it as a wireless microphone over Wi-Fi. (When Dragon presents its list of available audio sources,
choose “Dragon Remote Microphone application.”)

Note: If you have edition Premium or higher, you can add a source to an existing user profile. Otherwise, you
must create a profile for each type of audio source you wish to use (Mic-In, USB, or Dragon Remote
Microphone application).

Setting up a smart device is faster with a barcode

When you set up an Android or iOS smart device for use as a wireless microphone, Dragon offers a barcode, so
you can just point your device’s camera at the computer screen to capture the information that the Dragon
Remote Microphone Application needs.
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(Premium and above only) Enhanced Bluetooth wireless support:

In this release you can gain accuracy if you have a certified wideband Bluetooth microphone (with USB
dongle), such as the 16 kHz Plantronics Calisto II BT-300. You must plug the microphone’s dongle into your PC
before you open Dragon. Then, Dragon’s source list will include “Enhanced Bluetooth.”

Note: If you are upgrading a user profile for use with a 16 kHz Bluetooth microphone, you must add the
microphone to the profile as a new audio source.

(Professional and above only) Exporting custom words with their properties:
When you export your custom words (for safe-keeping or for use in other user profiles), you can choose XML as
the output format instead of txt, so that Word Properties (such as special spacing or spelling) will be included.

Note: Exported word lists do not include trained pronunciations.

(Professional and above only) AutoTranscribe Folder Agent enhancements:
The AutoTranscribe Folder Agent, which automatically schedules transcriptions of recordings found in a
particular folder into text files, formerly offered only .TXT as an output format. Now output is available in
.DOC and .RTF formats.

Administrators can also now set up automatic e-mail notification from the command line when a transcription
job completes, as explained in the Dragon NaturallySpeaking Administrator's Guide.

(Professional and above only) Auto-saving cumulative usage history:
Dragon Administrators can now turn on the automatic creation of recognition log files, a convenient way to
quickly obtain rich objective information about how end-users are using Dragon (commands, applications, audio
sources, etc.). This data can help provide targeted advice to end-users about how to get the most out of
Dragon. Recognition log files can also help Enterprises in gathering data for return-on-investment assessments.

Note: there is no graphical user interface for this feature (it is not accessible from any DragonBar menu.) See
the Administrator Guide for details.

Uninstallation

At the end of uninstallation, a message invites you to write feedback to Nuance, if desired. Also, a message
may appear asking whether you want to remove the version of Adobe Flash Player which Dragon 12 installed. (If
so, choose Yes.)
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What’s New in Version 11.5?

If upgrading from a version prior to Dragon 11, please also see What's New in Dragon 11, below.

Reminder: The Feature Matrix, available on the Nuance website, lists the feature differences between the editions of Dragon
NaturallySpeaking.

Improved User Profile Upgrade wizard: The wizard makes it easier to see how many profiles will be
updated. Important: To avoid making customers wait too long for their profile upgrade to complete,
Dragon processes only the most recent 30 minutes of acoustic data. (All corrections and new words
trained in upgraded profiles are migrated.) Nuance recommends that you run Accuracy Tuning as soon
as possible after the upgrade; this will ensure that the maximum amount of acoustic data is migrated to
your upgraded profile, thereby providing the best possible accuracy.

Using an iPhone or related device as a wireless microphone: Most people use Dragon by speaking
directly to their computers using the microphone included with their Dragon software purchase. But some
dislike being tethered to the PC. With the introduction of the free Dragon Remote Microphone
application, available in the iTunes app store, you can use your iPhone or related device as a wireless
microphone: as you dictate text or speak commands, the device transfers the audio data through a Wi-Fi
connection to Dragon on your computer. The Dragon Remote Mic app initially supports iPhones™, iPads™
and the iPod Touch™ 4 as wireless microphones running iOS 4.2, or later.

Improved interface for setting up a recorder source and transcribing audio files: The wizards make it
easier to properly set up a recorder as audio source and to transcribe recordings (including choosing
where the text will be transcribed). You can use a digital recorder, smartphone, or related device to
record your dictation for transfer to Dragon on your computer. Expanded Help and Tutorial links are also
provided.

Improved Dragon Sidebar: You can now shrink the Sidebar’s width to free up more of your screen.
Dragon remembers your width setting the next time you open it. Also, the Sidebar now provides new
information when you work in WordPad, the Vocabulary Editor, the Command Browser, or the Spelling
window. Note: At the bottom of the Sidebar are links to the Dragon Tutorial, in English editions of
Dragon.

“Undo all” for multiple text matches: Dragon 11 introduced the ability to apply commands such as “bold
<xyz>” and “capitalize <xyz>” to all visible instances of <xyz> in your text, thanks to the command
“choose all.” Saying “undo that” undoes the change for just the last instance of <xyz>. Dragon 11.5
introduces the "undo all" command to undo the change to all instances.

New commands for quotation marks and brackets: To speed up your editing, you can say "Quote That"
or "Bracket That" (or "Quote Selection" or "Bracket Selection”) and Dragon will enclose in quotation marks
or brackets what you selected, or last dictated. (Note: In UK English, “Bracket That” inserts the round
characters called parentheses in the US.) Also, you can say "Empty Quotes," or "Empty Brackets" to have
Dragon insert a pair of quotation marks or brackets so you can dictate something within them.

Commands to quickly post to Facebook or Twitter: Just select something you dictated or some text in
an editable document and say "Post that to Facebook," "Post that to Twitter," or "Tweet that." You can
also post something new that you dictate, by using the following commands: "Post to Facebook <xyz>,"
"Post to Twitter <xyz>," or "Tweet <xyz>," where <xyz> represents words you dictate along with the
command. For example, “Post to Facebook thank you to all who came out to support us today” or “Tweet
anyone know a great dentist in Burlington Vermont?” Dragon then brings up a dialog box where you can
complete or modify your text before it is posted.

Improved usability of the Spelling window: The Spelling window is revised to allow horizontal resizing,
to remember your last setting, and for improved readability.
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Link to Support: The DragonBar's Help menu now includes a direct link to the Web page for Nuance
Customer Service and Support.

Updated application support:

Internet Explorer 9 commands are added for using the One Box (which combines Web address entry and
the search box) and for pinning shortcuts to Web pages to the Windows Start menu.

After Dragon 11 introduced support for OpenOffice.org Writer 3.1 and 3.2, Dragon 11.5 extends that
support to 3.3.

Earlier versions of Dragon introduced support for Windows Live Mail 2009. Dragon 11.5 extends that
support to Windows Live Mail 2011 and provides improved online Help.

Improved control of where you can save a Roaming User Profile: Now anyone with administrator
privileges can set the “Prompt before saving to network location” option in the Administrative Settings
dialog, so that users can choose where to save their profiles. With this option enabled, when you close
Dragon or shut down or log off your computer, a dialog box appears letting you choose whether to save
your profile locally or to a master network location. If you are on a slow network, you can save your
profile locally to save time. When you're ready later, save it to the master location to make any updates
available at other network locations.

What’s New in Version 11.0?

Ellipsis (dot dot dot) triggers capitalization of the following word

You can modify this default through the Vocabulary Editor’s Properties button. If your usage of ellipsis is mostly for the end of
sentences (as opposed to within a sentence), you can keep this default; to handle the cases when you do NOT want the ellipsis to
trigger capitalization, you can say “no caps” right after the ellipsis.

Spoken forms do not allow punctuation

See examples in the Vocabulary Editor and the workbook.

Dictation commands (such as “cap” and “caps on”) are now lowercase

This can matter for users who create or modify custom commands that refer to dictation commands, in HeardWord statements for
instance. The Dictation Commands can be seen at the top of the Vocabulary Editor’s list.

The DragonBar menus and icons, including the former “Select-and-Say”

The DragonBar is designed to help you discover and quickly access important tools. In addition, it keeps important status indicators
close together: microphone status, the Text Control indicator, the Recognition Mode indicator, and messages from Dragon.

Full Text Control (formerly called "Select-and-Say"): The Text Control Indicator shows you the level of dictation support you can
expect for the text field where you currently have your cursor. In Microsoft Word or DragonPad, for instance, Dragon has Full Text
Control so the DragonBar shows a green checkmark (previous versions used a green ball). By contrast, where Dragon has only Basic
Text Control, such as in PowerPoint and Firefox, the checkmark is gray (previous versions used a gray ball).

The DragonBar now includes an icon indicating whether Dragon is in Normal, Dictation, Command, Numbers, or Spell Mode.

The menus are restructured provide easier access to important features. The former NaturallySpeaking menu is now called Profile;
it contains only items related to your profile, including Backup and Restore. The Words menu is now Vocabulary and only includes
Vocabulary-related features. The Accuracy Center has moved to the Help menu, under "Improve My Accuracy."

Dragon 11 menu name Pre-11 menu name

Profile NaturallySpeaking

Tools Tools

Vocabulary Words
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Modes Words

Audio Sound

Help (includes Accuracy Center) Help

Note: To access the DragonBar menus by voice, say "Switch to DragonBar" then the menu name. Once a menu is open, you can open
any of its items by saying its name.

Dragon's control menu, accessible by clicking the Dragon logo to the left of the microphone icon, provides clearer choices (Docked
to Bottom, Floating…) and direct access to the Dragon Options. The former "Close" choice is now labeled "Exit Dragon."
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New Results Display, and the former Results Box

When dictating, there’s no need to wait for Dragon to “catch up” with you — dictating in long phrases allows Dragon to transcribe
more accurately than dictating slowly and with numerous hesitations. As you speak, Dragon 11 indicates that it is processing by
displaying a small Dragon logo at your insertion point, and when you pause, your dictated words appear in your document. Our
research shows that this enables many users to dictate better, without being distracted by seeing the preliminary results
accumulating in the Results Box, as in previous versions. The traditional Results Box is still available from the View tab of the
Options dialog box.

New Sidebar displays commands and tips

An enhancement of the former Sample Commands window, the Dragon Sidebar provides important commands and tips at any time.
You can dock it on the left or right side of the screen, set it to auto-hide, or set it to "float" like other windows, place it anywhere,
and more. The Sidebar's top pane contains commands, including a tab for mouse commands, and the lower pane contains tips. By
right-clicking the Sidebar, you can display a menu to print the content, hide the Mouse tab or Tips pane, or switch to another
monitor. The Sidebar’s content depends on which application currently has focus.

More informative Accuracy Center, with links to Dragon Options and Auto-Formatting Options.

Redesigned Help and Tutorial

You can now launch a search in Dragon's Help at any time by saying "Search Dragon Help for <words>" (<words> represents your
search string). Dragon opens its Help window and displays your search results.

Correct or format multiple instances of text

Now when you tell Dragon to select, correct, or format text, if there are multiple instances of the text, Dragon displays a number
next to each instance. You can then choose to apply the command to one or all.

Improved switching between programs and windows

When you need to switch between windows, you can ask Dragon to display a numbered list so you can indicate your choice without
needing to know the exact name of the program or document. To display a list of open windows, you can say "List windows." To
show a list of open windows for just one program, you can say "List windows for Microsoft Word."

“Require "Click"” avoids unintentional actions on HTML pages

The "Require Click" option is on by default for hyperlinks in Dragon 11. You must say "Click" before saying the name of a hyperlink,
or part of the name. For example, on a Web page with a link for "Directions to our office," you could say "Click our office."

Scrolling commands in Internet Explorer, Mozilla Firefox, and Microsoft Word

New commands in the Spelling window (formerly called the Spell dialog box): "Modify <1-9 >" and "Edit <1-9 >" work like the
existing command "Select <1-9>" in this window. You can use them to designate an almost-correct choice so you can modify it.

Display search text before performing searches

In Dragon 10, the Web search commands executed the search automatically. In Dragon 11, you can edit the search string before it is
sent to your browser. The new Edit Search Keywords dialog box provides the option to correct, revise, or augment what you said in
your command. The option is on by default.

Direct searches for more Web sites: "Search <site> for <word(s)>" includes Facebook, Twitter, Bing, MySpace, and IRS.gov.

Administrative Settings always available

Dragon now keeps the Administrative Settings available from the DragonBar's Tools menu, even when you have a User Profile open.
The Administrative Settings dialog box contains important items, such as scheduling automatic Accuracy Tuning and choosing a
custom backup location – plus, in Windows XP, the disabling of ctfmon.exe, a program which can interfere with Dragon.

Command Browser interface
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Dragon 11 includes enhancements to the Command Browser that make it faster to use filter the display of commands by keywords.
Also, to shorten the list of commands displayed for specific contexts, Global Commands are omitted by default. You can easily
include them in the list by selecting the check box for "Include Global" on the Command Browser toolbar.

Improved recognition when multiple processors are available

Dragon now automatically detects computers with multiple processors and at least 2 GB of RAM, improving recognition by working
with this hardware. See Advanced - Choose Models for details about Advanced settings.

Don't Recognize That Word

Dragon now enables you, right from the Correction Menu, to prevent certain words from being recognized. For example, if you
dictate the name "Cassity" often and Dragon always hears "Cassidy," you can use Don't Recognize That Word on Cassidy.

Audio-quality alerts

Many misrecognitions are actually caused by poor audio input. To ensure that it receives the highest quality audio, Dragon 11
detects drops in audio quality and reminds you of typical causes, including microphone placement, excessive background noise, or if
your Bluetooth microphone battery is low. Dragon alerts you in various ways, depending on the severity of the problem.

Improved command and control

It's faster and easier to perform tasks such as opening applications and switching to a particular window, and Dragon 11 contains
commands for Windows itself, such as showing the Desktop, Control Panel, or folders such as My Documents and My Pictures. See
Windows Desktop commands for details.

Support for Microsoft Office 2010 (32-bit and 64-bit): includes Full Text Control and Natural Language Commands. See Using the
Microsoft Office ribbon for details.

Reduced memory usage during acoustic optimization: Dragon 11 uses significantly less memory than previous versions during
optimization. Running the Acoustic Optimizer regularly is important for improving your User Profile’s accuracy over time, and it is
easier to do in Dragon 11.

Full Text Control support for OpenOffice.org Writer: you can use, at any time, commands like "correct <xyz>" and "insert after
<xyz>.”

Easier names for popular programs: Dragon 11 recognizes shorter names for popular Windows programs. For example, now you can
say "Open Microsoft Word" rather than "Open Microsoft Office Word 2007."

Shift Ctrl mouse click voice commands: Dragon provides new voice commands for pressing the Shift and Ctrl keys by voice in
conjunction with right or left clicking the mouse. These options provide greater flexibility with certain Windows programs.

More file formats for use with digital recorders

Playback options added to the Text-to-Speech Options: control playback/rewind/fast forward speed (in %) and volume (in %).

Recognition History shows commands and timestamps: The Recognition History window, which displays the utterances from the
current session, now shows which utterances were recognized as commands, and provides a timestamp for all utterances. It also
lets you save the recognition history in text files, which may be useful if you need to contact Support.
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Speed, 49, 68
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Word Properties, 22, 41, 94, 103



Copyright  2013 Nuance Communications, Inc. All rights reserved 138


